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Section 1:
Introduction
The Adaptec® ARO™-1130xA RAIDport II™ Card provides powerful
disk array support in personal workstations/servers with RAIDport II
on-board.  ARO-1130CA is for workstations and ARO-1130SA is for
servers.

This Installation and Hardware Guide explains how to install the
ARO- 1130xA, run the Array1000xA BIOS & Driver Selection Utility,
create the first array, and then install the supporting software.

System Requirements
The minimum system requirements for the ARO- 1130xA are

§ A RAIDport II on-board system with an available
PCI/RAIDport II slot

§ A minimum of one SCSI hard disk drive

§ A standard 168-pin, 16-, 32-, or 64-MByte, EDO 3.3v, 60ns or
faster DIMM installed on the card. (See the Adaptec Web Site at
http:// www.adaptec.com/RAID for a list of approved DIMMs and
vendors.)

§ Five MBytes of free hard disk space for the ARO- 1130xA
software (five MBytes of free hard disk space on the Windows
system disk are also required for the temporary files created during
installation of the software)

§ Windows NT™ Workstation 4.0 or higher for ARO-1130xA or
Windows NT™ 4.0 Server, or Novell NetWare 3.12 or 4.11 for
ARO-1130SA

§ A 3.5-inch 1.44-MByte primary (boot) floppy disk drive
§ 64 MBytes or more of system memory recommended for Windows

NT Workstation/Server
§ CD-ROM drive recommended for installation of Adaptec CI/O™

Management Software
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Installation Overview
The steps involved in installing the ARO- 1130xA hardware and
software are:

1. Locate the PCI RAIDport II slot or expansion slot on the

motherboard.

2. Install the ARO- 1130xA in the RAIDport II on-board system.

3. Connect any additional SCSI devices to the RAID ready SCSI
connectors on the motherboard.

4. Run Array 1000xA BIOS & Driver Selection utility.
5. Create the first bootable array using the ArrayConfigxATM Utility

(see page 27)
6. Install the Array1000xA driver for your operating system.
7. Install the Adaptec CI/O Management Software on your

server/workstation
8. Install the Adaptec CI/O Management Software on your networked

client (optional/ARO-1000SA only)

Note: Before proceeding with installation, review the readme file
found on Disk 1 of the Adaptec CI/O Management Software for
Windows NT diskettes, or the readme file on the \winnt\disk1
directory of the Adaptec CI/O Management Software CD-ROM.
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Section 2:
Installing the ARO- 1130xA
and Connecting SCSI Devices
This chapter explains how to install your hardware. To install the ARO-
1130xA and devices, you must.

§ Verify presence of DIMM memory

§ Back up any existing data on drives to be used in array

§ Install the ARO-1130xA in your system/server

ARO- 1130xA Layout
Figure 2-1 identifies the major ARO- 1130xA components. You may
find it helpful to refer to this information while installing the ARO-
1130xA.
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Figure 2-1: ARO-1130xA Major Components.

Verifying Presence of DIMM Memory
Before you can use the ARO- 1130xA, the DIMM memory socket must
be populated with a 168-pin, 16-, 32-, or 64-MByte, EDO 3.3v 60ns or
faster DIMM for ARO-1000xA, as shown in Figure 2-2. Install a
DIMM if one is not yet installed. (See the Adaptec Web Site at
http://www.adaptec.com/RAID for a list of approved DIMMs and
vendors.)

Bus Contacts
Inserted into the
PCI/RAIDport II
expansion slot

LED Connector
Connects to the computer’s LED cable to
display activity on the SCSI bus

BIOS EPROM
Provides booting
capabilities from
a SCSI hard disk
or array

DIMM Memory Socket
Must be populated with
a 168-pin EDO, 3.3v
DIMM

Expansion Slot
Bracket
Secures the
RAIDport II card
inside your
computer
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Figure 2-2: Installing a DIMM in the DIMM Memory Socket.

Installing the ARO- 1130xA
Follow these steps to install the ARO- 1130xA:

Note: If you are installing the ARO- 1130xA in an existing system
that already has data, back up all data before continuing with
installation. You can restore the data later, once your ARO- 1130xA
arrays are created.

1. Turn OFF power to the computer, and disconnect the power cord.

2. Remove the cover from the computer case. (If necessary, refer to the

instructions in your computer documentation.)

3. Locate the PCI/RAIDport II expansion slot; unscrew and remove the
expansion slot bracket that covers the card-slot opening.

4. Insert the ARO- 1130xA in the slot; press down firmly so that the
bus contacts are securely seated in the slot. Secure the adapter

bracket with the screw you removed in Step 3, as shown in Figure

2-3.
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Figure 2-3: Installing the ARO-1130xA in a Typical PCI/RAIDport
II Expansion Slot.

Connecting the LED Activity Indicator
to the ARO- 1130xA
(Optional feature) An LED on the front panel of most computers lights
to indicate non-SCSI hard disk activity. If you would like that LED to
light whenever there is activity on SCSI channel A (controlled by
ARO- 1130xA) instead, you must disconnect the LED cable from the
motherboard and connect it to the LED connector on the ARO-
1130xA. If the LED has a two-position cable, connect the cable to pins
1 and 2 of the LED connector, as shown in Figure 2-4.

If the ARO- 1130xA supports multiple SCSI channels, and you want
the LED to light whenever there is activity on any of those channels,

Bus
Contacts

RAIDport II
Expansion Slot

RAIDport II
Card Bracket

Expansion Slot Bracket Screw

PCI Expansion Slots
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refer to your motherboard documentation for instructions on setting the
appropriate motherboard jumpers.

Note: If you are using non-SCSI disk drives (e.g., IDE), the LED
may no longer indicate activity on these drives when you connect
the LED cable to the ARO- 1130xA.

Figure 2-4: Connecting the LED Activity Indicator.

Completing the Installation
Once the ARO-1000xA is installed in your server/workstation, refer to
the documentation that came with your computer and SCSI devices for
specific instructions on setting up your SCSI devices and connecting
them to the SCSI connectors on the motherboard.

Note: If you refer to the computer’s documentation for installation
instructions on running the Array1000xA BIOS & Driver Selection
Utility and installing the software included in the package.

In most cases, it is not necessary to run the SCSISelect® utility.
Should you need to configure SCSI options (e.g., ID, Parity Checking,
and Termination), see Section 4, page 21, Configuring ARO-1130xA
with the SCSISelect Utility.

LED Connector on
ARO- 1130xA

2-pin LED Cable

LED Cable
1

1
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Connecting SCSI Devices
The ARO- 1130xA supports both internal and external SCSI devices.
Depending on the number of SCSI channels provided on the
motherboard.  Each channel supports up to 15 SCSI devices—either
16-bit devices alone or a combination of 16-bit and up to seven 8-bit
devices.

Note: If you are installing your SCSI devices inside an array
enclosure, see Connecting SCSI Array Enclosures (Storage
Subsystems) on page 14.

Choosing SCSI Cables
To connect your SCSI devices, make sure you have the appropriate
cable and connectors as described in the following table (see also Cable
Lengths on page 16 for additional information on cabling SCSI
devices):

To Install… You Will Need…
8-bit Internal SCSI
Devices

• A 50-pin internal SCSI cable with enough
connectors to accommodate all of your internal
SCSI devices.

16-bit Internal SCSI
Devices

• A 68-pin Ultra Wide internal SCSI cable with
enough connectors to accommodate all of your
internal SCSI devices.

8-bit External SCSI
Devices1

• A 50-pin internal-to-external SCSI port
expansion kit.
• A 50-pin external SCSI cable for each device.

16-bit External SCSI
Devices1

• A 68-pin Ultra Wide internal-to-external
SCSI port expansion kit.
• A 68-pin Ultra Wide external SCSI cable for
each device.

Array Enclosure • A 68-pin Ultra Wide internal-to-external
SCSI port expansion kit.
• A 68-pin Ultra Wide external SCSI cable.

                                                          
1 Use only high-quality external cables with a single ended impedance range of
80-110 ohms.
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Connecting Internal SCSI Devices
Follow these steps to connect internal devices:

1. Prepare each SCSI device for installation.
§ Make sure each device (internal and external) is assigned a unique

SCSI ID number from 0 to 15—no duplicate IDs are permitted on
a channel. (See SCSI ID Numbers on page 16 for additional
information.)

§ Install (or enable) the terminators on the internal device you are
attaching to the end of the cable only. (See SCSI Termination on
page 17 for additional information.)

2. Install and mount each internal SCSI device in an available drive

bay inside your computer. (Refer to your computer and device

documentation for instructions.)

3. If you are connecting 8-bit internal SCSI devices, attach one end of

the 50-pin cable to the 50-pin internal SCSI connector on the

motherboard. If you are connecting 16-bit internal SCSI devices,

attach one end of the 68-pin cable to the 68-pin internal SCSI

connector on the motherboard. Figure 2-5 shows a typical

installation of a 68-pin cable
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Figure 2-5: Attaching 68-pin Internal Ribbon Cable.

4. Attach the remaining connectors on the cable to the remaining

internal devices.

5. Connect an available DC power cable (from your computer’s power

supply) to the power input connector on each SCSI device.
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Connecting External SCSI Devices
To install external SCSI devices, you will first need to install an
internal-to-external SCSI port expansion kit. The kit usually consists of
a special cable that converts the internal SCSI connector on the
motherboard to an external SCSI connector on the chassis of your
computer. Refer to the expansion kit documentation for installation
instructions. Figure 2-6 shows a typical installation of a 68-pin Ultra
Wide internal-to-external cable.

Figure 2-6: Installing an Internal to External SCSI Port Expansion
Cable.

68-Pin Ultra
Wide Internal
SCSI Connector

68-Pin Ultra
Wide Internal-
to-External
SCSI Cable

68-Pin Ultra
Wide External
SCSI Connector



SUPERMICRO RAIDPort Manual

12

Once the SCSI port expansion kit is installed, follow these steps to
connect external SCSI devices:

1. Make sure each device (internal and external) is assigned a unique

SCSI ID number from 0 to 15—no duplicate IDs are permitted on

a channel. (See SCSI ID Numbers on page 16 for additional

information.)

2. If you are connecting 8-bit external SCSI devices, attach one end of

the 50-pin cable to the 50-pin external SCSI connector of the

expansion kit. If you are connecting 16-bit external SCSI devices,

attach one end of the 68-pin cable to the 68-pin Ultra Wide

external SCSI connector of the expansion kit (shown in Figure 2-

7.)

Figure 2-7: Attaching an External Cable to External SCSI
Connector.
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3. Attach the connector at the other end of the cable to either one of the

SCSI connectors on the external SCSI device, as shown in Figure

2-8. (If you are installing only one external device, attach a

terminating plug to the device.)

Figure 2-8: Attaching a Single External Device

4. Connect other external SCSI devices by daisy-chaining each device

to the previous device until all external SCSI devices have been

connected, as shown in Figure 2-9. (The device at the end of the

chain must have a terminating plug installed. See SCSI
Termination on page 17 for additional information.)
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Figure 2-9: Attaching Multiple External Devices.

Connecting SCSI Array Enclosures
(Storage Subsystems)
To help you conveniently manage your SCSI storage subsystems, a
variety of array enclosures are available from different manufacturers.
Figure 2-10 shows a typical setup between the array enclosure and the
system. To install your SCSI devices in these enclosures, refer to the
enclosure’s documentation. The following information is provided to
help you properly connect your enclosure to the system:

§ All rules for SCSI ID and termination must be followed when
installing SCSI devices in an array enclosure.

§ Ideally, the array enclosure itself should provide termination
capability and you should disable termination on all the drives in
the enclosure. If you terminate the SCSI bus by enabling
termination on a drive, you may run into problems if you have to
replace that drive and you then forget to terminate the replacement
drive.
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§ If the enclosure you are using for the array drives is not
specifically designed as an array enclosure (such as a standard
tower unit), be sure it has adequate cooling and ventilation.

Figure 2-10: A Typical Array Enclosure Setup.

Installation Hints for Connecting SCSI
Devices

All SCSI Devices

§ If you are booting your system from a single SCSI hard disk drive
or bootable array, the boot order of the disk or array must be set to
0. (See Making the Array Bootable on page 30.)

§ Termination power should be enabled on several or all SCSI
devices in the system (or array enclosure) so that if you remove a
drive that is supplying termination power other devices will still
provide it. The devices supplying termination power should be
located near the end of the bus.



SUPERMICRO RAIDPort Manual

16

§ Symptoms of SCSI cabling-related problems are drives that are not
recognized, drives that lock-up, or drives that deactivate.

§ Use good-quality SCSI cabling, and minimize the stub lengths.
Good- quality cables should not be limp when you pick them up.
The quality of the cable becomes much more critical when you use
higher-speed data transfer (i.e., UltraSCSI data transfer).

Cable Lengths
§ The total length of cabling (internal and external) on each SCSI

channel should not exceed the following:

–  Three m (9.8 ft) if you are using Fast SCSI data transfer rates (10
MBytes/sec) and have 1 to 15 devices (including the Array
controller).

–  Three m (9.8 ft) if you are using UltraSCSI data transfer rates (20
MBytes/sec for 8-bit devices, and 40 MBytes/sec for 16-bit
devices) and have four or less devices (including the Array
controller).

–  One and one-half m (4.9 ft) if you are using UltraSCSI data
transfer rates and have between four and eight devices (including
the Array controller).

Note: UltraSCSI data transfer rates do not currently support more
than eight devices per channel.

–  Six m (19.7 ft) if you are using 5-MByte/sec asynchronous or
synchronous data transfer rates.

§ When calculating the total length of the bus, be sure to include the
cabling inside any array enclosure.

SCSI ID Numbers
Each device attached to a SCSI channel supported by the ARO-
1130xA must be assigned a unique SCSI ID number—0 to 15 for Wide
(16-bit) devices, and 0 to 7 for Narrow (8-bit) devices. No duplicate
IDs are permitted on a channel.

§ We recommend that you leave the Array controller set to its
default setting of SCSI ID 7. If for some reason you need to change
the Array controller SCSI ID, see Section 4, page 21, Configuring
the ARO-1130xA with the SCSISelect Utility for instructions.

§ SCSI ID 7 has the highest priority on the channel. The priority of
the remaining IDs, in descending order, is 6 to 0, 15 to 8.
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§ If you have 8-bit SCSI devices, they must use SCSI IDs 0, 1, 2, 3,
4, 5, or 6. (To change the SCSI ID on your hard disk and other
SCSI devices, refer to the device’s documentation.)

§ If you wish to use a single SCSI disk drive (instead of an array) as
your boot device, we recommend that you set the SCSI ID for the
device to 0.

§ In general, use lower SCSI IDs for single disks and use higher
SCSI IDs for drives used as array members or spares.

SCSI Termination
To ensure reliable communication on the SCSI bus, terminators must
be installed (or enabled) on the devices at the physical ends of each
SCSI channel. The terminators on all devices between the physical ends
must be removed (or disabled).

To properly terminate the SCSI channel(s) on your system, refer to the
motherboard documentation. On most internal SCSI devices, the
termination setting is controlled by setting a jumper or a switch, or by
physically removing or installing a resistor module(s). On most
external SCSI devices, termination is controlled by installing or
removing a terminating plug (see Figures 2-8 and 2-9). Refer to the
device’s documentation to determine how to enable or disable
termination on your particular SCSI device.

Completing the Installation
Reinstall your computer cover and connect all power cables. To verify
that the SCSI devices work properly, turn ON the external SCSI
devices first, then turn ON the computer.  When the computer boots,
the Array1000xA Family BIOS sign-on message should appear on the
screen.  If the BIOS message does not appear, see, Troubleshooting on
page 51.

Note: If you need to configure the SCSI options (e.g., ID, Parity
Checking, and Termination) of the SCSI channels supported by the
ARO- 1130xA, see Section 5, Configuring the ARO-1130xA with the
SCSISelect Utility.
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Section 3:
Using the Array1000xA BIOS
& Driver Selection Utility

Whenever you install a new ARO-1130xA in your server/workstation
and before you run the Adaptec ArrayConfigxA program to create the
first array in your system, always run the Array1000xA BIOS & Driver
Selection Utility.

Caution:  We highly recommend that you back up the data on your
array(s) before you use the Array1000xA BIOS & Driver Selection
Utility.  This ensures that your data is completely protected.

The Array1000xA BIOS & Driver Selection Utility installs the ARO-
1130xA BIOS by automatically updating (flashing) the correct ARO-
1130xA BIOS.  The utility also determines which of the two Manager
Set driver diskettes (Disk A or Disk B) is required when you install the
operating system driver.

Running the Array1000xA BIOS &
Driver Selection Utility
The Array1000xA BIOS & Driver Selection Utility is provided on a
bootable floppy disk and runs under SOS as a stand-alone utility.  A
simple-to-use interface prompts you through the process.  Follow these
steps to run the Array1000xA Bios & Driver Selection Utility:

1. Insert the Array1000xA BIOS & Driver Selection Utility diskette
in driver A and reboot your server/workstation.  The utility starts
automatically and the initial Array1000xA BIOS & Driver
Selection Utility screen appears.

Note:  The initial Array1000xA BIOS & Driver Selection Utility
screen identifies which of the two Manager Set driver diskettes
(Disk A or Disk B) are required when you install the operating
system driver.  Make a note of which diskette to use, and continue
with step 2.
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2. Select either Express or Advanced setup.

Note: If you receive an “Unsupported Hardware Configuration,”
message during setup, contact the system manufacturer.  The
ARO-1130xA is not supported by the system manufacturer.  The
ARO-1130xA is not supported by the system.

§ Express setup automatically updates the ARO-1130xA BIOS.
Select Express setup and the utility will do the rest.  When
prompted, remove the floppy disk and press any key to reboot the
server/workstation.  Continue with Step 6

§ Advanced setup also allows you to update the ARO1130xA BIOS.
In addition, Advanced setup allows you to select other options
such as:

–  Display Current BIOS Checksum.  Determines current version of
the ARO-1130xA BIOS.

–  Display New BIOS Checksum.  Determines version of the BIOS
available on the floppy.

–  Save current BIOS to a File.  Saves the current ARO-1130xA
BIOS to a file

–  Erase Current BIOS.  Erases the current ARO-1130xA BIOS

To access these options, select Advanced setup and continue with Step
3.

3. From the Main Menu, select the array adapter card you want to
upgrade (only available array adapters can be selected).  The
Utility Menu appears.

4. Make a selection from the Utility Menu.
5. Follow the instructions on the screen.
6. When prompted, remove the Array1000xA BIOS & Driver

Selection Utility diskette from drive A and reboot your
server/workstation.
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Section 4:
Configuring the ARO- 1130xA
with the _SCSISelect Utility
The Array1000xA _SCSISelect® configuration utility allows you to
change controller settings without opening the computer or handling
the controller. This section describes the default settings, explains when
you should change them, and gives instructions for doing so.

Array1000xA _SCSISelect also includes SCSI disk utilities to list the
SCSI IDs of devices controlled by the ARO- 1130xA, format SCSI disk
drives, and check them for defects. Instructions for using these utilities
are included.

Default _SCSISelect Settings
The default _SCSISelect settings, shown in the table below, are
appropriate for most systems. For situations where you might want or
need to change the settings, see the descriptions of each setting
beginning on page 24. To change any setting, or if you would like to
run the _SCSISelect utilities, see Starting the SCSISelect Utility on
page 22.

SCSI Bus Interface Definitions Default
Host Adapter SCSI ID 7
SCSI Parity Checking Enabled
Host Adapter SCSI Termination Enabled
Host Adapter UltraSCSI Disabled
SCSI Device Configuration Default
Initiate Sync Negotiation Yes (Enabled)
Maximum Transfer Rate 40.0 MBytes/

sec2

Enable Disconnection Yes (Enabled)
Initiate Wide Negotiation3 Yes (Enabled)
Send Start Unit Command No (Disabled)

                                                          
2 If Wide SCSI is not supported on the motherboard, the default setting is 20.0
Mbytes/sec.
3 The Option is available only if Wide SCSI is supported on the motherboard.
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Include In BIOS Scan Yes (Enabled)
Additional Options Default
Array 1000 BIOS Enabled
BIOS Support for Bootable CD-ROM Disabled

Starting the _SCSISelect Utility
To start _SCSISelect, press Ctrl-A when the following prompt appears
when you turn on or reboot your computer:

Press <Ctrl><A> for SCSISelect (TM) Utility!

The menu that appears displays the options Configure/View Host
Adapter Settings and SCSI Disk Utilities, as shown in Figure 4-1.

Figure 4-1: _SCSISelect Menu

Using _SCSISelect Menus
To select a _SCSISelect menu option, move the cursor to the option
with the arrow up and arrow down keys, then press Enter. In some
cases, selecting an option displays another menu. You can return to the
previous menu at any time by pressing Esc.

To restore the original _SCSISelect default values, press F6 from the
main _SCSISelect screen. To toggle the display between color and
monochrome modes, press F5 from the main _SCSISelect screen (this
feature does not work on some monitors).
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Exiting _SCSISelect
To exit _SCSISelect, press Esc until a message prompts you to exit (if
you changed any host adapter settings, you are prompted to save the
changes before you exit). Select Yes to exit, then press any key to
reboot the computer. Any changes you made in _SCSISelect take effect
after the computer/server boots.

Using the SCSI Disk Utilities
To access the SCSI disk utilities, select the SCSI Disk Utilities option
from the menu that appears after starting _SCSISelect. Once the option
is selected, _SCSISelect immediately scans the SCSI bus (to determine
the devices installed) and displays a list of all SCSI IDs and the devices
assigned to each ID.

When you select a specific ID and device, a small menu appears,
displaying the options Format Disk and Verify Disk Media.

§ Format Disk—This utility allows you to perform a low-level
format on a hard disk drive. Each hard disk drive must be low-
level formatted before you can use your operating system’s
partitioning and file preparation utilities, such as MS-DOS Fdisk
and Format.

Most SCSI disk devices are preformatted at the factory and do not need
to be formatted again. The Adaptec Format Disk utility is compatible
with the vast majority of SCSI disk drives.

Caution: A low-level format destroys all data on the drive. Be sure
to back up your data before performing this operation. You cannot
abort a low-level format once it is started.

§ Verify Disk Media—This utility allows you to scan the media of a
hard disk drive for defects. If the utility finds bad blocks on the
media, it prompts you to reassign them; if you select yes, those
blocks are longer used. You can press Esc at any time to abort the
utility.
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SCSISelect Settings

SCSI Bus Interface Definitions
The following settings are the _SCSISelect settings most likely to
require any modification.

§ Host Adapter SCSI ID— This option sets the ARO- 1130xA’s
SCSI ID. The default setting is SCSI ID 7, which gives the ARO-
1130xA the highest priority on the SCSI bus. We recommend that
you leave the ARO- 1130xA set to SCSI ID 7.

§ SCSI Parity Checking—This option determines whether the
ARO- 1130xA verifies the accuracy of data transfer on the SCSI
bus. The default setting is Enabled. You should disable SCSI
Parity Checking on the ARO- 1130xA and all SCSI devices if any
SCSI device supported by the ARO- 1130xA does not support
SCSI parity; otherwise, leave it enabled. Most SCSI devices do
support SCSI parity. If you are not sure whether a device supports
SCSI parity, consult the documentation for the device.

§ Host Adapter SCSI Termination—This option is used in
conjunction with your motherboard termination settings. Refer to
your motherboard documentation for instructions on properly
setting termination.

§ Host Adapter UltraSCSI—This option determines whether the
ARO- 1130xA supports UltraSCSI data transfer speeds. The
default setting is Disabled. If you have any UltraSCSI devices
installed, you should enable this setting. When this setting is
enabled, the ARO- 1130xA negotiates for data transfer speeds of
up to 20 MBytes/sec (40 MBytes/sec for Wide SCSI devices).

Note: If you use UltraSCSI data transfer speeds, be sure to use
high-quality cables to connect the disk drives supported by the
ARO- 1130xA. The quality of the cable is much more critical when
you use higher-speed data transfer.

SCSI Device Configuration

The SCSI device settings allow you to configure certain parameters for
each device on the SCSI bus. To configure settings for a specific
device, you must know the SCSI ID assigned to that device. If you are
not sure of the SCSI ID, see Using the SCSI Disk Utilities on page 23.
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§ Initiate Sync Negotiation—This option determines whether
synchronous data transfer negotiation (Sync Negotiation) between
the device and ARO- 1130xA is initiated by the SCSI channel
controlled by the ARO- 1130xA. Normally, you should leave
Initiate Sync Negotiation set to enabled, because most SCSI
devices support synchronous negotiation and because it allows for
faster data transfer. The default setting is Yes.

§ Maximum Transfer Rate—This option determines the maximum
data transfer rate that the SCSI channel controlled by the ARO-
1130xA supports. The default setting is 20.0 MBytes/sec (10
MBytes/sec for motherboards that do not support Wide SCSI). (The
effective data transfer rate is doubled when Initiate Wide
Negotiation is set to Yes. For example, a transfer rate of
20 MBytes/sec becomes 40 MBytes/sec.)

§ Enable Disconnection—This option determines whether the SCSI
channel controlled by the ARO- 1130xA allows the SCSI device to
disconnect from the SCSI bus (sometimes called
Disconnect/Reconnect). The default setting is Yes.

You should leave Enable Disconnection set to Yes if two or more
SCSI devices are supported by the ARO- 1130xA. If only one
SCSI device is supported by the ARO- 1130xA, you can set Enable
Disconnection to No to achieve slightly better performance.

§ Initiate Wide Negotiation—This option determines whether the
SCSI channel controlled by the ARO- 1130xA attempts 16-bit data
transfer instead of 8-bit data transfer. The default setting is Yes.
(The effective data transfer rate is doubled when 16-bit data
transfer is used. For example, a transfer rate of 10 MBytes/sec
becomes 20 MBytes/sec.)

§ Send Start Unit Command—This option determines whether the
Start Unit Command is sent to the SCSI device at bootup (most
devices do not require this). The default setting is No.

§ Include in BIOS Scan—This option determines whether the
ARO- 1130xA BIOS supports hard disk drives attached to the
SCSI channel controlled by the ARO- 1130xA. When set to Yes,
the ARO- 1130xA BIOS controls the hard disk drive. When set to
No, the ARO- 1130xA BIOS does not control the hard disk drive.
The default setting is Yes.
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Additional Options

Array1000xA BIOS
This option determines whether the ARO- 1130xA BIOS is installed at
boot time. When set to Enabled, the ARO- 1130xA BIOS is installed,
and all Int13 (except bootable CD-ROM) devices are supported. When
set to Disabled, the ARO- 1130xA BIOS is not installed. The default
setting is Enabled.

BIOS Support for Bootable CD-ROM
This option determines whether the ARO- 1130xA BIOS supports
booting from a CD-ROM drive. When set to Enabled, the ARO-
1130xA allows booting from a CD-ROM drive.
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Section 5:
Creating the First Array With
the _ArrayConfigxA
Program/Utility
This chapter explains how to use the Adaptec _ArrayConfigxA
program/utility to create the first bootable or nonbootable array on your
computer.  ArrayConfigCA is for NT workstations and ArrayConfigSA
is for NT Servers and NetWare servers.

Before creating the array, make sure the disks for the array are
connected and installed in your computer (or array enclosure). You can
use _ArrayConfigxA in two ways:

Note: ArrayConfigxA runs from a self-booting diskette.  If you are
changing the configuration of a server/workstation that is already
in use on a network, log all users off the system and shut it down
in an orderly manner before you start ArrayConfigxA.  Refer to Part
2 of this manual, Adaptec CI/O Array Management Software Guide,
for further information.

Creating an Array for ARO-1000xA

Follow these instructions to create the first Array with ArrayConfigxA:

1. Insert the ArrayConfigxA diskette in the server’s drive A and
reboot the server.  ArrayConfigxA starts automatically.

2. Select Disk Array Operations from the Main Menu.
3. Select Create New Array From the Disk Array Operations

menu.
4. Type a new array and press Enter.  The name can be up to 15

characters long and can include spaces and any other printable
characters.

5. Select an array type.  Your options are:

–  RAID 0: Data is striped across the disks in a RAID 0 array,
allowing for faster I/O performance than a single disk.  RAID 0
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arrays do not store redundant data; if any disk in the array fails, all
data is lost.

–  RAID 1: Data is mirrored on a pair of disks.  If one disk fails, data
is available.  The actual data capacity of the array equals half the
available disk space.

–  RAID 5: (This applies to ARO-1000SA only.)  The array
contains redundant (parity) data distributed across all disks in the
array.  If an one disks fails, data can be reconstructed from the
parity information.  If a second disk fails before the array has been
reconstructed, all data is lost.  The actual usable data capacity of
the array is equal to one less than the total number of disks. ( One
disk’s worth of capacity is needed to hold the parity information.)

–  RAID 0/1: (This applies to ARO-1000SA only.)  Data is striped
and mirrored on two or more pairs of disks.  If one disk in a pair
fails, data is available.  The actual data capacity of the array equals
half the total available disk space.

See Part 2 of this manual for more information on selecting RAID
level.

6. Select the number of drives you want in the array and press
Enter.  This number should not include spares (drives that
automatically replace failed array drives).  The number of
drives available for assignment is listed on the screen.

Note: This step does not apply to RAID 1 arrays, which have two
drives by definition.

7. Select array members.  When the next screen appears, press
Tab to highlight a channel (if more than one SCSI channel is
available).  Select drives for the array by pressing the arrow up
and arrow down keys until the drive name is highlighted, and
then press Ins or Enter.  The names of selected drives that
appear in the Adaptec Array # box.

To select drives on a different channel press Tab to select another
channel and then select the drives from the SCSI Ids on Channel menu.
To deselect the drive you most recently added, press Del.

Caution: A warning appears if you select a disk that has partitions.
Do not select a partitioned disk if it contains data you want to
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keep, because any existing data will be erased when the disk
becomes part of the array.

When you have selected the number of drives you specified in step 6
the next screen appears automatically.  If you are creating a RAID 1,
RAID 0/1, or RAID 5 array, and if there are any unassigned drives, the
screen prompts you to define dedicated spare drives for the array.  (We
recommend that you use a spare pool instead of dedicated spares.)

Note: A spare must have at least the capacity of the smallest drive
in the array.

8. Select spares.  If you do not want a spare, type n and continue
with step 10.  If you want to select dedicated spares, follow
these steps:

a. At the prompt, type y.
b. At the next prompt, type 1 or 2.
c. Select one or two spares, using the same method you used to

select disks for the array.

9. Initialize array.  When the Initialize Mode menu appears,
select Initialize Array to Zero.  Formatting begins
immediately.  A graph on the screen shows the progress of this
operation.

Caution: If the drives contain data, all the data is lost when you
initialize the array.

Select Low-Level Format only if the drives were previously formatted
on another computer or if you think they may have surface defects.
Low-level formatting takes a long time for large disk drives.

10. Select array block size.  When the menu of block sizes
appears, select a block size.  (This menu does not appear if the
array is a mirrored array with only two drives.)

The allowable block sizes are 8, 16, 32, 64 (the default), and 128 KB.
The default block size gives the best overall performance in most
network server/workstation environments.

11. Wait for initialization to complete.  When you see the message
Initialization of [array name] is complete, press any key to
return to the Disk Array Operations menu.
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12. Create additional arrays.  To create additional arrays (if disks
are available), return to Step 3.  When all arrays are created,
exit ArrayConfigxA, remove the ArrayConfigxA diskette, and
reboot the server.  After you reboot you can write data to the
arrays.

At this point, you can make your initial array bootable as described in
the next section.

Making the Array Bootable
You can make the array bootable so that the computer boots from the
array instead of from a stand-alone (single) disk.

To make the array bootable, the array must be set to #0 in the boot
order. We recommend that you make your initial array bootable.
Follow these steps if you want the computer to boot from the newly
created array:

Note: The computer/server will always attempt to boot from any
installed non-SCSI disks (for example, any IDE disk drive at drive
C). You must disable or remove all non-SCSI disks if you want the
computer to boot from a SCSI disk or array.

1. Insert the _ArrayConfigxA diskette in the computer’s floppy disk

drive A.

2. Reboot the computer/server from the diskette. _ArrayConfigxA

starts automatically.

3. Select Display Boot Order from the Main Menu. The Boot Order

for Singles and Arrays window appears.

4. If the newly created array is at the top of the list, preceded by the

words Unit 0, no changes are necessary; if it has some other unit

number, highlight the array name and press Enter.

5. Use the arrow keys to move the selected array to the top of the list.

Then press Enter. If you want to change the boot order of another

array, select it, move it with the arrow keys, and press Enter again.

6. Press Esc to return to the Main Menu.
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7. Exit _ArrayConfigxA, remove the diskette from drive A, and reboot
the computer.

8. Prepare the array as you normally would prepare a boot disk drive
for your operating system. See page 33, Installing Software on a
Windows NT System or page 39, Installing Software on a Novell
NetWare Server.

Note: You cannot use this procedure to change the boot order of a
SCSI disk drive that is not part of an array.  If you want to do this,
create a one-disk RAID 0 array from the disk.  (Data is not actually
striped on a one-disk array.)
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Section 6:
Installing Software on a
Windows NT System
This chapter explains how to install the software required to use the
ARO- 1130xA in a system using Windows NT 4.0 workstation/server.
ARO-1000CA is for NT workstations and ARO-1000SA is for NT
Servers.

Before installing the software, make sure the ARO- 1130xA is already
installed. If you plan to boot from an array, make sure the array is
already created. To install all of the software, you must complete the
following in the order presented:

§ Install the Array1000xA driver for Windows NT

§ Install the Adaptec CI/O Workstation/Server Array Management
Software for Windows NT

Note: If your RAIDport II system has an additional Adapted AHA®-
2940, AHA-3940, or any other AIC™-78x0 based host adapter
installed (which is not associated with the RAIDport), the driver for
these adapters must be from the Adaptec 7800 Family Manager Set
1.3 or later

Installing the Array1000xA Driver for
Windows NT
This section explains how to install the Array1000xA Miniport Driver
(cda1000.sys) for Windows NT. To begin driver installation, see either
Installing the Driver When Installing Windows NT below, or Installing
the Driver When Windows NT is Already Installed on pages 34 and 35.

Note: We recommend that you install your Windows NT operating
system on an array to take advantage of the performance or
redundancy features of the array.



SUPERMICRO RAIDPort Manual

34

Installing the Driver When Installing
Windows NT
To install the cda1000.sys driver when you are installing Windows NT,
follow the instructions below.

Note: If you have multiple arrays, we recommend temporarily
powering off all devices except for the boot array before installing
Windows NT; otherwise, Windows NT limits the size of the
partitions you can create to 1 GByte. When Windows NT
installation is complete, power on all devices and reboot the
system.

To install the cda1000.sys driver when you are installing Windows NT
4.0, follow these steps:

1. Start your system with the Windows NT Boot Diskette in the floppy
disk drive or the Windows NT Boot CD-ROM in the CD-ROM
drive.

Note: To install Windows NT from a bootable CD-ROM, make sure
BIOS Support for Bootable CD-ROM is enabled in SCSISelect.

2. Boot diskette installation: When prompted, insert diskette #2 in your
floppy drive. After a few moments you will see a blue screen. To
setup Windows NT now, press Enter and continue with Step 3
below.

Boot CD-ROM installation: When the following message appears
onscreen, press the F6 key and skip to Step 4 below.

Setup is inspecting your computer’s hardware…

3. Press S to skip autodetection of your SCSI host adapter.
4. Press S again to specify an additional device.

5.  Press Enter to select Others; insert the appropriate Adaptec
Array1000xA Family Manager Set driver diskette in your floppy
disk drive.
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6. The screen displays the adapter drivers supported on the diskette.
Select the Adaptec Array1000xA Family Adapter and press Enter.

7. If you want to add drivers for other host adapters (other than the
ARO- 1130xA), do so at this time by pressing S and repeating Step
5 for each additional adapter and inserting the appropriate disk
provided by the hardware manufacturer.

8. Press Enter to continue with the Windows NT operating system
setup. Follow the onscreen instructions in the Windows NT
documentation to complete the installation.

Installing the Driver When Windows
NT is Already Installed
To update or install the cda1000.sys driver if Windows NT is already
installed, follow the instructions below.

Updating Windows NT 4.0

To install the cda1000.sys driver when Windows NT 4.0 is already
installed, follow these steps:

1. Start Windows NT.

2. Click the Start button on the Windows NT task bar, and then point
to Settings.

3. Click the Control Panel.

4. Double-click the SCSI Adapters icon.

5. Click the Drivers tab, and then click the Add button.

6. In the Install Driver window, click the Have Disk button.

7. Insert the Adaptec Array1000xA Family Manager Set drivers
diskette into drive A; enter the following path to the installation
files and then click OK.

a:\winnt

The Adaptec Array1000xA Family Adapter is highlighted by default.

8. In the Install Driver window, Click OK.
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9. Click the New button when asked if you want to use the currently
installed driver(s) or install new one(s).

10. Type a:\winnt again, and click Continue. The driver is now
installed.

11. You must restart your computer for the changes to take effect.
Click Yes to restart your computer.

Installing Adaptec CI/O
Workstation/Server Array Management
Software for Windows NT
Note: The Adaptec CI/O Management Software installation process
automatically installs both CI/O server and client components on
your Windows NT Server.  Before you start the Adaptec CI/O
Management Software, be sure that communication with the server
via the network is already established. (See the documentation
provided with your TCP/IP software for instructions on
establishing communications, and also Hints for Establishing
Communications With Your Server on page 48)

Follow these steps to install the Adaptec CI/O Workstation/Server
Array Management Software for Windows NT:

1. Start Windows NT.

2. Insert the Adaptec CI/O Workstation/Server Array Management

Software CD-ROM in your CD-ROM drive. If you are installing

the software from diskettes, insert Disk 1 of the Adaptec CI/O

Workstation/Server Array Management Software for Windows NT

in the floppy disk drive.

3. Select Run from the File menu, type the following and press Enter:

[pathname]setup.exe

(The setup.exe file is located at \win_nt\disk1\setup.exe on the CD-
ROM, and at \setup.exe on Disk 1 of the Adaptec CI/O Workstation or
Server Array Management Software for Windows NT.)

4. Follow the directions that appear on the screen.
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5. When installation is complete, reboot the system. The following NT
Services start automatically in the background:

ARO-1000CA ARO-1000SA
§ CIO Array

Management Service
§ CIO Array

Management Service
§ CIOArrayManager

RPC Command
§ CIOArrayManager

RPC EventP
§ CIOArrayManager

RPC Event
§ NobleNet Portmapper

Note: This NT Service is configured to start automatically at boot
time. After installation you can start or stop this service through
the Services icon in the Windows NT Control Panel.

6. Double-click the CI/O Array Management Software icon to start

the program.

See Part 2: Adaptec CI/O Array Management Guide, for information on
using the Adaptec CI/O Workstation/Server Array Management
Software to add, delete, or manage your arrays. If you are experiencing
problems starting the software, see Problems Running the Software On
Your Windows NT

Note: (This note applies to ARO-1000SA only) You must have the
proper level of Adaptec CI/O Management Software password
authorization if you want to add and delete arrays and spares from
a networked client.  The default password is “adaptec.” See Part 2
of this manual for information on setting security options.
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Section 7:
Installing Software on a Novell
NetWare Server
IMPORTANT: All of the following section (Section 4) applies to
ARO-1000SA only.

This chapter explains how to install the software required to use the
ARO-1130SA in a novell NetWare (NetWare 3.12 and 4.11) server.
Before installing the software, make sure the ARO-1130SA is already
installed.  If you have not already done so, run the Array1000SA BIOS
& Driver Selection Utility (see page 19) to determine which of the two
Manager Set driver diskettes (Disk A or Disk B) is required to install
the NetWare driver.  If you plan to boot from an array, make sure the
array is already created.  To install all of the software, you must
complete the following in the order presented:

§ Install the cda 1000.dsk driver for Novell NetWare
§ Install the TIRPC Communications Module
§ Install the Adaptec CI/O Management Software for Novell

Netware

Once all software is installed, refer to the Adaptec CI/O management
Software, Part 2 of this Manual, for instructions on adding, deleting and
managing your arrays from the server console.

Note: If your RAIDport II system has an additional Adaptec AHA-
2940, AHA-3940, or any other AIC-78x0 based host adapter
installed, the NetWare driver form these adapters must be from the
Adaptec 7800 Family Manager Set 1.3 or later.

Installing the Array1000SA Driver for
Novell NetWare
This section explains how to install the Adaptec Array1000SA driver
(cda 1000.dsk) for NetWare.  To begin driver installation, see either
Installing the Driver When Installing NetWare below, or Installing the
Driver When NetWare is Already Installed on pages 40 and 42.
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Note:  We recommend that you install your Novell NetWare
operating system on an array to take advantage of the redundancy
and performance features of the array.

Installing the Driver When Installing
NetWare
To Install the cda1000.dsk driver when you are installing NetWare,
follow the instructions below for the version of NetWare you are
installing.

NetWare 4.11
Follow these instructions only if you are installing NetWare 4.11 for
the first time:
1. Follow the procedures in your NetWare documentations for

installing a new server.
2. When a screen appears that asks you to select a disk driver,

press Enter.
3. Press Insert to install an unlisted driver.
4. Insert the appropriate Adaptec Array1000xA Family Manager

Set Driver Diskette (Disk A or Disk B) into your floppy disk
drive.  (See Running the Array1000xA BIOS & Driver
Selection Utility on page 19 to determine the appropriate
driver diskette.)

5. Press F3 and specify the path to the cda1000.dsk driver.  For
NetWare 4.1, the driver is located in \netware\v4_1x on the
diskette.

6. Select cda1000.dsk and press Enter.
7. When prompted to save the current version of aspitran.dsk,

select Yes or No.
8. When prompted to save the current version of nwpaload.nlm,

select Yes or No.
9. When the message File “A:\netware\v4_1x\nwpaloas.nim

was not found…” appears, ignore the message and press
Enter to continue.

10. Select Continue copying the next file.
11. Select Yes to install an additional disk driver.
12. Select aspicd.dsk and press Enter.
13. When prompted to so save current version of aspicd.dsk,

select No.
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14. When Prompted to save current version of aspicd.ddi, select
No.

15. Select No when prompted to install an additional disk driver.
16. Select Continue Installation.
17. Press Enter to Continue.
18. Down and exit the server.  At the DOS prompt, copy the

nwpa.nlm, nbi.nlm, and nwpaload.nlm files (located on the
Novell Installation CD-ROM) to the server’s startup directory
(usually c:\nwserver).

Note: To load the driver automatically at Server bootup, make sure
the starup.ncf file includes the load command line for the cda
1000.dsk driver. (If you also have an Adaptec host adapter that
uses the Adaptec aic78xx.dsk driver, make sure the driver loads
after the cda1000.dsk driver.)

NetWare 3.12
Follow these instructions only if you are installing NetWare 3.12 for
the first time:

1. Follow the procedures in your NetWare documentation for
installing a new server.  (For information on using a CD-ROM
drive on a NetWare server, see Appendix C, Using a CD-
ROM Drive.)

2. When you See the NetWare colon prompt (:), use the load
command to install the driver from the appropriate Adaptec
Array1000xA Family Manager Set driver diskette (Disk A or
Disk B).  See Running the Array1000xA BIOS & Driver
Selection Utility on page 19 to determine the appropriate
driver diskette.)

The correct syntax to load the cda1000.dsk driver is :

:load [pathname]cda1000

(For example, :load a:\netware\v3_1x\cda1000)

Note: To load the drivers automatically at server bootup, copy the
aspitran.dsk and cda1000.dsk drivers to the server’s startup
directory and modify the startup.ncf so that the proper path to the
driver is specified.

The aspitran.dsk, because NetWare attempts to load this file
automatically.  If you also have an Adaptec host adapter that used the
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Adaptec aic78xx.dsk driver, make sure the driver loads after the
cda1000.dsk driver.

3. Load the NetWare install program from the NetWare colon
prompt (:load install).  Follow the instructions in the NetWare
documentation to complete the installation (e.g., creating disk
partitions, system volumes, etc.) of your server.

Installing the Driver When NetWare is
Already Installed
To update or install the cda1000.dsk driver if NetWare is already
installed, follow the instructions in this section.  The procedures are
similar for all versions of NetWare.  Procedures that are specific to a
NetWare version are noted when necessary.

1. Copy the cda1000.dsk and aspitran.dsk files from the
appropriate Adaptec Array1000SA Family Manager Set driver
diskette (Disk A or Disk B) into the server’s starup directory
(e.g., c:\nwserver, c:\server.312) on your hard disk drive.  (see
running the Array1000xA BIOS & Driver Selection Utility on
page 19 to determine the appropriate driver diskette.)

Note: For Netware 3.12, the cda1000.dsk and aspitran.dsk files are
located in the \netware\v3_1x subdirectory on the diskette; for
NetWare 4.11, the files are in \netware\v4_xx.

2. If necessary, modify the load command line in the startup.ncf
so that the proper path to the driver is specified.  The correct
syntax to load the cda1000.dsk driver is:

Load [pathname]cda1000

Note: If you unload cda1000.dsk driver, you must also unload
cioams.nlm.  When you load cda1000.dsk driver again, you must
also load cioams.nllm.  If cioams.nlm is not unloaded when you
unload cda1000.dsk, your system may work erratically.
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Installing the TIRPC Communications
Module
The TIRPC communications module must be installed before you
install the Adaptec CI/O Management Software.  The module allows
communications between the server and remote clients. Follow the
instructions below for the version of NetWare installed.

NetWare 3.12

1. Insert the Adaptec CI/O Management Software in your CD-
ROM drive. If you are installing the software from diskettes,
insert Disk 1 of the Adaptec CI/O Management Software for
NetWare (TIRPC).

2. From the NetWare colon prompt (:), type the following and
press Enter:

Load install

3. Select Product Options from the Installation Options Menu.
4. Press the <Ins> key.
5. Enter the path to the CD-ROM or Disk 1 (do not include the

backslash).
6. Select Netware 3.x TIRPC Runtime and Configuration

Files.  (TIRPC must be installed in the sys:system directory
only.)

NetWare 4.11

1. Insert the Adaptec CI/O Management Software CD-ROM in
your CD-ROM drive.  If you are installing the software from
diskettes, insert Disk 1 of the Adaptec CI/O Management
Software for NetWare (TIRPC).

2. From the NetWare colon prompt (:), type the following and
press Enter:

Load install

3. Select Product Options from the Installation Options Menu.
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4. Select Install a Product Not Listed.
5. Press <F3> key.
6. Enter the path to the CD-ROM or Disk 1 (include the

backslash).
7. Select NetWare 4.0 TIRPC Runtime and Configuration

Files. (TIRPC must be installed in the sys:system directory
only.)

Installing the Adaptec CI/O
Management Software for Novell
NetWare
Note: Before you start the Adaptec CI/O Management Software, be
sure that communication with the server via the network is already
established. (See the documentation provided with your TCP/IP
software for instructions on establishing communications, and
also Hints for Establishing Communications with your Server on
Page 48.

Follow these steps to install the Adaptec CI/O Management Software
for Novell NetWare:

1. Insert the Adaptec CI/O Management Software CD-ROM in
your CD-ROM drive.  If you are installing the software from
diskettes, insert Disk 2 of the Adaptec CI/O Management
Software for NetWare in the floppy disk drive.

2. From the NetWare colon prompt (:), type the following and
press Enter:

Load [pathname]nwsetup

(The nwsetup NLM is located at \netware\disk2\nwserup.nlm on the
CD-ROM, and at \nwsetup.nlm on Disk 2 of the Adaptec CI/O
Management Software for NetWare.)

Note: If you are using NetWare 3.12, you may receive a Failed to
allocate resources error message at this point.  This is because the
CD-ROM (or floppy disk drive) is not part of the default search
path.  If this happens, you must add the CD_ROM or floppy disk
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drive to your search path by entering the following command
before loading nwsetup:

Search add [pathname]

3. From the NWSETUP Installation menu, select Default
Installation or Custom Installation (press F1 for help).

4. At the end of the installation process, select Yes when you are
prompted to update the autoexec.ncf file. (This adds the
appropriate NLM command lines to the file so that all
software is automatically loaded when the server starts.)

See the Adaptec CI/O Management Software User’s Guide for
information on using the Adaptec CI/O Management Software to add,
delete, or manage your arrays from your server console.

Adaptec CI/O Management Software
Installation Hints
§ For Communications supported over TCP/IP, the tcpip.nil must be

loaded and the IP protocol must be bound to a valid IP address.
The IP protocol generally needs to be bound to an ethernet frame
type, ETHERNET_II, which must be specified when loading the
LAN driver. A LAN driver can be loaded multiple times for
different ethernet frame types.

§ Command lines similar to the following are automatically added to
the autoexec.ncf file when you run the nwsetup utility:

#

# NWSETUP LAST UPDATE XX-XX-XX
#
RPCSTART
IOMGR.NCF
IOMGRSRV.NCF
IOMGRRPC.NCF



SUPERMICRO RAIDPort Manual

46



SUPERMICRO RAIDPort Manual

47

Section 8:
Installing Software on a Remote
Client
IMPORTANT: All of the following section (Section 8) applies to
ARO-1000SA only.

This chapter explains how to install the Adaptec CI/O Management
Software on a remote network client running under Windows
(Windows 3.1x, Windows® 95, and Windows NT). If you want the
capability to manage your arrays on the server from a remote
networked client, continue with the remainder of this chapter.  Once
installed, refer to Part 2 of this manual, Adaptec CI/O Management
Software User’s Guide, for instructions on using the software.

Installing Adaptec CI/O Management Software

Following these steps to install the software:

Note: Before you start the Adaptec CI/O Management Software, be
sure that communication with the server via the network is already
established.  As long as communication is established, it is not a
requirement to log-on to the server to install the software and to
monitor the server via the network (See the documentation
provided with your TCP/IP or SPX/IPX software for instructions on
establishing communications with your Server on page 48.)

1. Start Windows on the client.
2. Insert the Adaptec CI/O Management Software CD-ROM

drive.  If you are installing the software from diskettes, insert
Disk 1 of the Adaptec CI/O Management Software for
Windows 95 and Windows NT Clients.

3. Select Run from the File menu (Windows 95 and NT users
select Start, and then Run), type the following and press
Enter.

[pathname]setup.exe

(The setup.exe file is located in \win_client\disk1\setup.exe on the CD-
ROM, and in \setup.exe on Disk 1 of the  Adaptec CI/O Management
Software for Windows 95, and Windows NT Clients.)
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4. Follow the directions that appear on the screen.
During the following installation you will be prompted to enter the host
name of the client PC.  If you do not know the host name, you can add
the information later by inserting a line in the autoexec.bat file.
Instructions for this step appear on the screen during installation.

See the Adaptec CI/O Software User’s Guide, Part 2 of this manual, for
information on using the Adaptec CI/O Management Software to add,
delete, or manage your arrays from the remote client.

Note: You must have the proper level of Adaptec CI/O Management
Software password authorization if you want to add and delete
arrays and spares from a networked client.  The default password
is “adaptec.”  See Part 2 of this manual, the Adaptec CI/O
Management Software User’s Guide, for information on setting
security options.

Hints for Establishing Communications with
your Server

Communication with the server via the network must be established
prior to installing the Adaptec CI/O Management Software on a
networked client.  The following information is provided to help you
set up proper communication:

TCP/IP Networks

§ When installing your TCP/IP software (not provided by
SUPERMICRO or Adaptec), follow the installation instructions
provided with your TCP/IP software. You will be asked to enter
information such as IP address, host name, host file, etc.

§ The TCP/IP stack uses the host name from TCP/IP setup.

SPX/IPX Networks

§ On an SPX/IPX network, make sure to install the NetWare Client
Software for Windows (provided by Microsoft). During
installation, certain DLLs required by the Adaptec CI/O
Management Software are installed.
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§ The host name is identified through the SET RPCHOST=
environment variable.  You can enter this variable through the
setup process, or you can manually add it to the autoexec.bat file.

Note: Under dual stack situations, we recommend using the same host
name for both TCP/IP and SPX/IPX to minimize any naming
confusion.
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Appendix A:
Troubleshooting

Troubleshooting Checklist
Check the following if you have problems installing or running the
ARO- 1130xA and SCSI devices:

§ Does the ARO- 1130xA BIOS sign-on message appear during
bootup? If not, check the following items:

–  Is the ARO- 1130xA properly seated in a PCI/RAIDport expansion
slot? Refer to your computer documentation for the slot location.

–  Does your computer CMOS setup require you to enable PCI bus
parameters (see your computer documentation)? If so, run the
CMOS Setup program and assign the parameters—usually IRQ,
Enable PCI Slot, and Enable Master.

–  Have you run the Array1000xA BIOS & Driver Selection?

§ Is the SCSI bus terminated properly, and are all SCSI devices
turned on?

§ Are all SCSI bus cables and power cables connected?

§ Does each channel and each device on the channel have a unique
SCSI ID?

§ If you are having trouble booting from a SCSI disk drive or array,
make sure your computer’s CMOS setup is set to No Drives
Installed (the required setting for SCSI drives). Also, verify that
the drive or array has been selected as the boot-first (boot) device
and that the boot partition is active.

Problems Running the Software On
Your Windows NT
If the Adaptec CI/O Workstation/Server Array Management Software
does not start when you double-click the program icon and you see a
warning box with Unable to Initialize IOMAPI, try the following:
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§ Verify that the following NT service has a status of Started
(double- click the Services icon in Control Panel). If it does not,
select the service and press the Start button:

ARO-1000CA ARO-1000SA
§ CIO Array

Management Service
§ CIO Array

Management Service
§ CIOArrayManager

RPC Command
§ CIOArrayManager

RPC EventP
§ CIOArrayManager

RPC Event
§ NobleNet Portmapper

§ Make sure you have the proper security access rights to the
Windows NT services. The Windows NT services can be started,
stopped, paused, etc., according to the NT service security rules
defined by Microsoft (refer to the Windows NT documentation for
more details).

§ Verify that the Registry was updated correctly during installation.
If the values do not match the values listed below, try reinstalling
the Adaptec CI/O Workstation/Server Array Management
Software:

–  The correct entries for
HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services\
CIOArrayManagement are:

DisplayName: REG_SZ: CIO Array Management
Service (v x.xx)
ErrorControl: REG_DWORD: 0x01
ImagePath: REG_SZ: [Pathname specified during

installation]iomgr.exe
ObjectName: REG_SZ: LocalSystem
Start: REG_DWORD: 0x02
Type: REG_DWORD: 0x110
SharedMemName: REG_SZ: iomgr.shm

–  The correct entries for
HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services\
EventLog\System\CIOArrayManagement are:
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EventMessageFile: REG_SZ: [pathname to system32
directory]\system32\iomgrmsg.dll
TypesSupported: REG_DWORD: 0x7

§ Verify that the following DLLs are located in your system32
directory. If they are not present, try reinstalling the Adaptec CI/O
Workstation/Server Array Management Software:

ctl3dnt.dll
xnmhb420.dll
xnmhn420.dll
xnmte420.dll
msvcrt20.dll
mtld.dll
xnmba420.dll
iomgrmsg.dll

§ Verify that the following files are located in the directory where
you installed the Adaptec CI/O Workstation/Server Array
Management Software. If they are not present try reinstalling the
software:

iomgr.ems
cioams.hlp
cioams.exe
readme.txt
iomgr.exe
iomgr.ini
iomgr.msg

Using the ARO- 1130xA with an
AHA-2940 Family Host Adapter
This section explains how to use an ARO- 1130xA and an AHA-2940
Family host adapter in the same computer system. In order to do this,
you must load drivers. You also may need to make changes to the
Windows NT registry.

Caution: We recommend that you do not attempt these
configuration changes unless you are an experienced computer
user.

Two scenarios are presented. Choose the one that matches what you
want to do.
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Scenario #1: Adding an ARO- 1130xA to a
System with an AHA-2940 Family Adapter

These instructions assume that Windows NT is already installed on the
computer system and that the boot drive is currently connected to the
AHA-2940 Family adapter. If the ARO- 1130xA is already installed,
shut down the computer system, remove the ARO- 1130xA from the
expansion slot, and restart the system.

Installing the ARO- 1130xA Driver

1. Start the Windows NT Control Panel and double click the SCSI

Adapters icon.

2. Click the Drivers tab and click Add.

3. Click Have Disk …, and insert the Array1000xA Family Manager
Set diskette in the floppy disk drive. (This diskette was included

with your ARO- 1130xA adapter.)

4. When the Install from Disk dialog box appears, type A:\winnt on

the command line and click OK.

5. Select Adaptec Array1000xA Family Adapter and click OK.

6. When a message appears asking you if you want to restart
Windows NT, click No.

7. Exit from Control Panel.

Changing Registry Settings

1. Back up the NT Registry, using one of the techniques described in
Backing up the Windows NT Registry on page 60.

Caution: It is very important to back up the NT Registry before you
make any changes to it. This allows you to restore the original NT
Registry settings if there is a problem with the new configuration.

2. Run the Registry Editor (regedit.exe).

3. When the Registry Editor window appears, expand the tree on the
left until you can see the nodes under

\HKEY_LOCAL_MACHINE\System\CurrentControlSet\Services.
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4. Select cda1000 on the left part of the screen. Write down the
cda1000 Tag value that appears on the right part of the screen.

The Tag value is a hex number followed by an equivalent decimal
equivalent in brackets: for example, 0x00000002 [2].

5. Select aic78xx on the left part of the screen. Write down the aic78xx

Tag value that appears on the right part of the screen.

6. Expand the tree on the left until you can see the nodes under

\HKEY_LOCAL_MACHINE\System\CurrentControlSet\Control\

GroupOrderList.

7. Select GroupOrderList.

8. Click the right mouse button on SCSI Miniport on the right side of

the window and select Modify from the popup menu. A table

appears with columns of two- and four-number groups, something

like this:
0005 02 00 00 00 03 00 00 00
0010 01 00 00 00 01 01 00 00
0015 04 00 00 00 05 00 00 00
0020 06 00 00 00 07 00 00 00
etc.
This table of hexidecimal numbers indicates the Tag-value
sequence in which the SCSI Miniport drivers are loaded when
you start Windows NT.

9. Determine what the Tag value loading sequence is. Here is how
you do this:

a) Ignore the four-digit groups on the left of each row.

b) Going from left to right, and starting on the first row, divide the

two-digit numbers into groups of eight. In this example, the groups

are
02 00 00 00
03 00 00 00
01 00 00 00
01 01 00 00
etc.

You need to write down all the number groups from all rows in the
table.
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c) In each group of eight numbers, reverse the sequence of the two-
digit pairs, like this:

00 00 00 02
00 00 00 03
00 00 00 01
00 00 01 01
etc.

d) Write down the series of resulting numbers, without all the extra
zeroes. In this example, it is 2, 3, 1, 101, etc. This is the Tag value

loading sequence for SCSI Miniport drivers. In other words, when

Windows NT loads these miniport drivers, the one with Tag value

2 is loaded first, then the one with Tag value 3, and so on.

10. Compare the Tag value loading sequence to the actual tag values

of cda1000 and aic78xx that you determined in steps 4 and 5. If

cda1000 is loading before aic78xx, skip to step 16. If aic78xx is

loading first, continue with the next step.

11. Expand the tree on the left until you can see the nodes under

\HKEY_LOCAL_MACHINE\System\CurrentControlSet\Services.

12. Select cda1000 on the left part of the screen. Click the right mouse

button on Tag Value on the right part of the screen and select

Modify from the popup menu.

13. Type the tag value of the aic78xx miniport driver in the space
provided and click OK.

14. Select aic78xx on the left part of the screen. Click the right mouse

button on Tag Value on the right part of the screen and select

Modify from the popup menu.

15. Type the tag value of the cda1000 miniport driver in the space
provided and click OK. You have now reversed the tag values for

the two miniport drivers, and the cda1000 driver will load first.

16. Exit from the Registry Editor and from Windows NT. Then shut

down the computer system.
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17. Physically install the ARO- 1130xA in the PCI/RAIDport
expansion slot.

18. Attach your boot drive to one of the SCSI channels controlled by
the ARO- 1130xA and boot the computer system.

Scenario #2: Adding an AHA-2940 Family
Adapter to a RAIDport II System with an
ARO-1130xA
These instructions assume that Windows NT is already installed on the
computer system and that the boot drive is connected to the SCSI
channel controlled by the ARO- 1130xA. If the AHA-2940 Family
adapter is already installed, shut down the computer system, remove
the adapter from the slot, and restart the system.

Installing the AHA-2940 Family Driver

1. Start the Windows NT Control Panel and double click the SCSI

Adapters icon.

2. Click the Drivers tab and click Add.

3. Click Have Disk …, and insert the AIC-78xx Family Manager Set
diskette in the floppy disk drive. (This diskette was included with

your 2940 Family adapter.)

4. When the Install from Disk dialog box appears, type A:\winnt on the

command line and click OK.

5. Select Adaptec Adaptec AHA-294x/AHA-394x or AIC-78xx PCI

SCSI Controller and click OK.

6. When a message appears asking you if you want to restart
Windows NT, click No.

7. Exit from Control Panel.

Changing Registry Settings

1. Back up the NT Registry, using one of the techniques described in

Backing up the Windows NT Registry on page 60.
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Caution: It is very important to back up the NT Registry before you
make any changes to it. This allows you to restore the original NT
Registry settings if there is a problem with the new configuration.

2. Run the Registry Editor (regedit.exe).

3. When the Registry Editor window appears, expand the tree on the
left until you can see the nodes under

\HKEY_LOCAL_MACHINE\System\CurrentControlSet\Services.

4. Select cda1000 on the left part of the screen. Write down the

cda1000 Tag value that appears on the right part of the screen.

The Tag value is a hex number followed by an equivalent decimal
equivalent in brackets: for example, 0x00000002 [2].

5. Select aic78xx on the left part of the screen. Write down the aic78xx
Tag value that appears on the right part of the screen.

6. Expand the tree on the left until you can see the nodes under
\HKEY_LOCAL_MACHINE\System\CurrentControlSet\Control\

GroupOrderList.

7. Select GroupOrderList.

8. Click the right mouse button on SCSI Miniport on the right side of
the window and select Modify from the popup menu. A table

appears with columns of two- and four-number groups, something

like this:
0005 02 00 00 00 03 00 00 00
0010 01 00 00 00 01 01 00 00
0015 04 00 00 00 05 00 00 00
0020 06 00 00 00 07 00 00 00
etc.

This table of hexidecimal numbers indicates the Tag-value sequence in
which the SCSI Miniport drivers are loaded when you start
Windows NT.

9.  To determine what the Tag value loading sequence is:
a) Ignore the four-digit groups on the left of each row.
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b) Going from left to right, and starting on the first row, divide the
two-digit numbers into groups of eight. In this example, the groups

are
02 00 00 00
03 00 00 00
01 00 00 00
01 01 00 00
etc.

You need to write down all the number groups in all rows of the table.

c) In each group of eight numbers, reverse the sequence of the two-

digit pairs, like this:
00000002
00000003
00000001
00000101
etc.

d) Write down the series of resulting numbers, without all the extra

zeroes. In this example, it is 2, 3, 1, 101, etc. This is the Tag value

loading sequence for SCSI Miniport drivers. In other words, when

Windows NT loads these miniport drivers, the one with Tag value

2 is loaded first, then the one with Tag value 3, and so on.

10. Compare the Tag value loading sequence to the actual tag values

of cda1000 and aic78xx that you determined in steps 4 and 5. If

cda1000 is loading before aic78xx, skip to step 16. If aic78xx is

loading first, continue with the next step.

11. Expand the tree on the left until you can see the nodes under

\HKEY_LOCAL_MACHINE\System\CurrentControlSet\Services.

12. Select cda1000 on the left part of the screen. Click the right mouse
button on Tag Value on the right part of the screen and select
Modify from the popup menu.

13. Type the tag value of the aic78xx miniport driver in the space

provided and click OK.

14. Select aic78xx on the left part of the screen. Click the right mouse

button on Tag Value on the right part of the screen and select

Modify from the popup menu.
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15. Type the tag value of the cda1000 miniport driver in the space
provided and click OK. You have now reversed the tag values for

the two miniport drivers, and the cda1000 driver will load first.

16. Exit from the Registry Editor and from Windows NT. Then shut

down the computer system.

17. Physically install the AHA-2940 Family adapter in the expansion

slot.

18. Boot the computer system.

Backing up the Windows NT Registry
It is very important to back up the Windows NT Registry before
making any changes to it. This will allow you to recover if the changes
make your system unusable. Here are two ways to back up the
Windows NT Registry. The backup utilities described here are included
with NT Workstation/Server:
§ Use the ntbackup utility to create a tape copy of all data files and

Registry information. Be sure to select the Backup Local Registry
option when performing the backup.

§ Run the rdisk utility with the /s option to create a copy of the
Registry on a hard disk. (A typical backup file is 5 MBytes to
10 MBytes in size.) Then use xcopy or some other command to
copy the information to removable media. You must have the three
NT boot floppy disks to restore an RDISK-saved registry to your
computer system.
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Appendix B:
Advanced Topics

Installing Multiple Adapters
You cannot install more than one ARO- 1130xA card in the same
system unless the system is designed with more than one
PCI/RAIDport slot; however, you can install an ARO- 1130xA in
computers that have other PCI-, ISA-, or EISA-based host adapters
installed. When installing multiple adapters, keep the following
considerations in mind:

§ All drives in a single array must be connected to the same host
adapter. A single array cannot be created with drives from two or
more host adapters.

§ If you are booting from a SCSI disk drive or array supported by the
ARO- 1130xA, then the ARO- 1130xA must be the card that the
computer scans first. Some computers boot from the device with
the lowest PCI device number; others boot from the device with
the highest number. (See also Making the Array Bootable on page
30.) You can disable the BIOS on cards that are scanned before the
desired boot card.

§ In systems with EISA- and ISA-based host adapters, the boot host
adapter must have the lowest BIOS base address. The system
BIOS automatically controls the ARO- 1130xA base address (the
user has no control over the assigned address).
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Appendix C:
Using a CD-ROM Drive with
DOS
To operate a SCSI CD-ROM drive connected to the ARO- 1130xA
under DOS, you need:

§ The SCSI driver, aspi8dos.sys (version 1.30 or later)

§ The CD-ROM driver, aspicd.sys

§ The Microsoft CD-ROM extensions, mscdex.exe

The aspi8dos.sys and aspicd.sys files must be copied from the Adaptec
Array1000xA Family Manager Set drivers diskette to a directory (e.g.,
c:\scsi) on your hard disk drive. The mscdex.exe file is included with
MS-DOS 6.x and above (see your MS-DOS documentation for details).

Note: If you use MS-DOS 5 and do not have mscdex.exe, we
recommend that you upgrade to MS-DOS 6 or above. You can also
obtain mscdex.exe from Microsoft’s Web site, online bulletin
board, or CompuServe forum.

To complete the driver installation, edit the config.sys file to include
command lines for aspi8dos.sys and aspicd.sys, and edit the
autoexec.bat file to include a command line for mscdex.exe. The
following examples illustrate the command line format and the
command options appropriate for most systems.
§ Sample command lines for config.sys file:

device=c:\scsi\aspi8dos.sys /d
device=c:\scsi\aspicd.sys /d:aspicd0

§ Sample command line for autoexec.bat file:

\dos\mscdex.exe /d:aspicd0 /M:12

(This assigns the CD-ROM the next available drive letter, typically D if
there is only one DOS drive.)

The following tables describe the aspi8dos and aspicd command line
options. For a description of mscdex command line options, see your
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Microsoft DOS documentation. You can type command line options in
uppercase or lowercase letters. Leave a blank space between options.

Command Line Options for aspi8dos.sys

Option Example Use
/ccbs<count> /ccbs8 Specifies the maximum number of concurrent

ASPI commands that can be supported. The
valid range is 1 through 16. The default is 4. If
you increase this value, the size of the ASPI
manager also increases. Use this option only if
you want to run an ASPI program that specifies
a higher number of concurrent commands.

/d /d Displays information about the ARO- 1130xA
and attached SCSI devices when the computer
boots.

/L /L Enables aspi8dos to recognize all eight possible
LUNs associated with each SCSI ID. If the
option is not used, aspi8dos can recognize only
LUN 0 for each SCSI ID.

/mn /m1 Causes aspi8dos to scan the PCI bus. The
method used to scan the bus is determined by
the value of n:
/mb = scan PCI bus using PCI BIOS calls
/m1 = scan PCI bus using Mechanism #1
/m2 = scan PCI bus using Mechanism #2
aspi8dos automatically scans the PCI bus for
SCSI devices. It tries to determine which
scanning method will work best for the given
system configuration. Use the /mb, /m1, and
/m2 options only if you want to override the
aspi8dos internal scanning mechanism. Usually
aspi8dos can determine which scanning method
is optimal for your system. (PCI BIOS calls are
described in the PCI BIOS spec; scanning
mechanisms #1 and #2 are described in the PCI
spec.

/norst /norst Prevents aspi8dos from resetting the SCSI bus
when you boot your computer. By default,
aspi8dos resets the SCSI bus when you boot the
computer if the host adapter BIOS is not
present. You can use /norst to prevent this from
happening.
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Option Example Use
/pause /pause Pauses the system after loading aspi8dos at

bootup, so you can read the message on the
screen. After you read the message, press any
key to resume booting.

/rst /rst Forces aspi8dos to reset the SCSI bus when you
boot your computer. By default, aspi8dos does
not reset the SCSI bus when you boot your
computer if the host adapter BIOS is present.

/s<slot num-
ber>

/s1/s3 Indicates the slot number(s) where you want
aspi8dos to look for host adapters. Valid slot
numbers = 1 to 15. If you do not use this option,
aspi8dos scans all slots for host adapters,
beginning at slot 1.

/d:<name> /d:aspicd0 Required in the config.sys command line.
Assigns a name to the CD-ROM drive so that
mscdex can assign the CD-ROM a logical drive
letter. The name must exactly match the CD-
ROM drive name in the mscdex command line
in autoexec.bat. Use any eight- character name.

/id={…} /id=2+4
/
id=3+5+1:
4

Specifies CD-ROM drives controlled by aspicd.
By default, aspicd controls all drives. In the first
example, which is for a computer with one host
adapter, aspicd controls the devices with SCSI
IDs 2 and 4. In the second example, for a
computer with two host adapters, aspicd
controls the devices with SCSI IDs 3 and 5 on
host adapter 0 and SCSI ID 4 on host adapter 1
(if you do not specify the host adapter number,
aspicd assumes it is 0).

/L /L Enables aspicd to recognize all eight possible
LUNs associated with each SCSI ID. If the
option is not used, aspicd can recognize only
LUN 0 for each SCSI ID. Add the /L option to
the command line if you have a CD-ROM drive
that can access multiple discs.
If your computer system includes a Pioneer
DRM-600 or DRM-604x multiple-disc CD-
ROM drive, you do not need to add the /L
option. The aspicd device driver automatically
scans multiple LUNs if it detects one of these
devices on the SCSI bus.
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Option Example Use
/norst /norst Prevents aspicd from issuing a SCSI Bus Reset

message at system start-up. The default is to
issue it. The SCSI Bus Reset message
(supported by Toshiba, Hitachi, and NEC
drives) resets drives that are playing audio CDs
when the computer reboots.

/pause /pause Makes your system pause after loading aspicd at
bootup, so you can read the message on the
screen. Press any key to resume booting.

/type:<drive
vendor>

/type:sony Allows aspicd to support audio play mode for
CD-ROM drives that are compatible with a
supported drive type but are not included on the
list of supported drives. If you use the /
type:<drive vendor> option, aspicd assumes
that all CD-ROM drives on the SCSI bus are
made by this vendor—you cannot combine
different brands of CD-ROM drives on the bus.
The valid entries for this option are chinon,
denon, hitachi, lms, nec, panasonic, sony, texel,
and toshiba.
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Appendix D:
Using the SNMP Agent
(This section refers to ARO-1000SA only)

This section provides information on using the SNMP agent for
NetWare and Windows NT.  A section describing how to load MIBs in
the MIB database is also provided.

NetWare
1. Modify the traptarg.cfg file which specifies SNMP trap

destinations.
a. Open the traptarg.cfg (sys:\etc\traptarg.cfg) file using any

editor.
b. Scroll down to the Protocol IPX section of the file.
c. For each client PC which is to receive traps using the IPX

network protocol, add a line to the file that includes the IPX
network protocol, add a line to the file that includes the IPX
network number (8 digits) and the MAC address (12 digits) of
the client PC.  Include a tab character before the IPX Network
Number.  For Example:

(Tab000000002:008DAD088E24)

When all of the appropriate entries are added, the Protocol IPX section
should look something like the following.

Protocol IPX
00000002:008DAD088E24
00000002:0080AD0761EC

2. Similar to instructions for the Protocol IPX section, edit the
traptarg.cfg file to specify IP addresses mapped to MAC
addresses for each client PC which is to receive traps using the
TCP/IP network protocol.

3. Start the SNMP agent
a. Load the SNMP agent by entering the following command:

Load cio20 [c<string>] [v]
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b. The optional parameters are:

C<string>

Load the agent using the SNMP community name contained in
<string>.  The default SNMP community name is “public”.

v

Load the agent in verbose mode, which will cause debugging
information to be sent to the console.

Note: The I/O Manager must be loaded prior to loading the SNMP
agent.

Windows NT
The SNMP agent is automatically installed when you install Adaptec
CI/O Management Software.

There are no command line options for the CI/O agent; however, if a
file named ciosnmp.vb is placed in the I/O Manager installation
directory, the CI/O SNMP agent will write a debugging trail to a file
named ciosnmp.log in the same directory.  It does not matter what the
contents of the ciosnmp.vb file are.  The log file will be over written
each time the NT SNMP agent is restarted.

Note:  The I/O Manager must be loaded prior to loading the SNMP
agent.

Loading MIBs in the MID Database
Follow the procedure below to load MIBs in the MIB database while
running HP Open View.  For more complete information refer to the
Managing MIB Data section of the HP Open View Manual.

1. Select the Options:Load/Upload MIBs:SNMP menu item,
the MIB Load/Upload MIBs:SNMP dialog box appears,
listing the MIBs currently loaded.

2. Click the Load button.  The load MIB from File dialog box
appears, listing the files in the default directory.
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3. Browse the CI/O Setup Diskette and double-click the MIC file
you want to load.  The MIB is automatically loaded and the
MIB Load/Unload MIBs dialog box reappears, showing the
list of currently loaded MIBS.

4. The MIB name is now included in the Loaded MIBs scrollable
list.

If a MIB does not load properly, you will receive an error message.
The problem could be one of the following:

–  A syntax error in the MIB.  The MIB loader error message
contains the MIB where the error is occurring.

–  The vendor’s MIB.  For example, the vendor’s MIB might not
match the version for the device that is on the network.

5. Click Close to exit this operation.
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Part 2
Adaptec® CI/O™
Management Software
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Section 1:
Getting Started
This document explains how to view SCSI devices and manage arrays
with the Adaptec® CI/O™ Management Software. It includes
instructions on using all the software features and also information on
how to replace drives, reconstruct arrays, etc.

Software Overview
Adaptec CI/O Management Software— You install the Windows®

client version of Adaptec CI/O Management Software on networked
clients running under _Windows 3.x, Windows®  95, or _Windows NT™

 3.51 or 4.0. This program is used to monitor and manage server and
array activities, giving you access to information on multiple servers to
which the client is connected via the network.

Note: This program only supports AIC-78xx devices with the
Adaptec 7800 Family Manager Set v. 2.10 or higher or
Array1000™xA devices with the Array1000xA Family Manager Set v.
3.1 or higher.

Using the Adaptec CI/O Management
Software
Here is some general information on using the Adaptec CI/O
Management Software most effectively. Use the Table of Contents and
the Index to find instructions for specific software commands.
Use Adaptec CI/O Management Software to monitor the status of SCSI
devices, arrays, and other devices on the server. This software allows
you to receive status updates from multiple remote servers. You can
simultaneously monitor servers running under different operating
systems.

§ Use Adaptec CI/O Management Software to set up regularly
scheduled verification of fault-tolerant arrays and testing of spares.
Respond immediately to arrays in Critical status, and replace failed
spare disks promptly.
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§ Use Adaptec CI/O Management Software, running either on the
server console or on a networked client, to add, delete, or
reconfigure arrays after the server has already been in use. (You
need special access rights to change the server configuration.)

§ We recommend that you create a bootable array and boot the
server from the array instead of from a stand-alone disk drive. You
can create a bootable array with either Adaptec CI/O Management
Software or the _ArrayConfigSA program.

§ Use the password feature of Adaptec CI/O Management Software
to prevent unauthorized users from changing your array
configuration.

§ Be sure that arrays are adequately protected with spare pools
(recommended) or dedicated spares. You can create and delete
spares with any of the array management software programs.

Note: Your Adaptec product also includes the diskette-based
_ArrayConfigSA Initial Boot Array Installation Utility, which you
can use to create arrays and spares. You can use _ArrayConfigSA
to create an initial bootable array for the server.
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Section 2:
Entering and Viewing Server
Information
Adaptec CI/O Management Software allows you to view events taking
place on multiple servers. In addition, you can view the configuration
of SCSI devices, arrays, and other hardware on the server(s). This
chapter explains how to view client and server information.

Entering and Viewing Server
Information

Adding a New Server Address

You must enter information about each server you want to monitor with
Adaptec CI/O Management Software. Once this information is
recorded in a configuration file, Adaptec CI/O Management Software
automatically finds the server(s) when restarting the application.

Follow these steps to add a new server address to Adaptec CI/O
Management Software :

1. Start the program by double-clicking the  icon in the Adaptec
CI/O Management Software group.

2. Click the  button. The New Server dialog box appears, as

shown in Figure 2-1.
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Figure 2-1: New Server Dialog Box

3. Select the IP or IPX radio button to indicate which kind of access is
the default.

4. Enter the server’s name or IP/IPX address, which can be up to 32
characters. This name will appear beneath the server icon in the
Server View window.

–  Servers running under NetWare usually use IPX protocol. Select
the IPX button and type the name of the server. To view the server
name, open Windows File Manager and select Connect Network
Drive from the Disk menu. Then view the scrollable list of server
names. If an error message appears when you click OK in the New
Server dialog box, verify the server name and the use of IPX with
the System Administrator.

If you need to enter an IPX address, the format is xxxxxxxx.xx- xx-xx-
xx-xx-xx, where the first eight x’s are hex digits that define the network
number, and the six pairs of hex digits are the host address or MAC
address.

–  Servers running under Windows NT usually use IP protocol. For
Windows NT you can always enter the server address, if you know
it. Otherwise, enter the server name. This could be something like
mainserver or mainserver.unisystem.com. Be sure that your
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networked client is set up with either a host file or with the name
of a domain resolver. Ask the System Administrator if you are not
sure.

The format of a TCP/IP address is nnn.nnn.nnn.nnn, where each group
of three decimal digits is a number between 0 and 255 (for example,
123.23.45.145).

5. Enter a description of the server—for example, Application Server
or Video Server. This description appears when you double-click
the server icon in the Server View window.

6. Click OK to add the new server information. You will see one of the
following error messages if the server name/address is not correct:

–  RPC transport error. This means that you entered a server
address with correct IP or IPX syntax, but there is no server with
this address. Check your typing for errors and try again.

–  Transport not present. This means that the selected protocol
transport is not present.

–  Duplicate server exists. This means that you entered a server
name or address that has already been added for this networked
client monitoring list.

Viewing and Editing Server Information

Follow these steps if you need to enter or change a server’s network
address information from the top menu bar of the CI/O Management
Software main screen:

1. Click the  button on the toolbar. The Server View window
appears. Each server is represented by an icon in the top part of the

window. The appearance of the icon indicates the server status, as

shown here:

Server is online and available.

Server is unavailable, perhaps due to a network failure. The
Adaptec CI/O will automatically attempt to reattach to the server for a
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user-selectable time (default is 10 minutes). Double-click the server
icon at any time to attempt a reattach.

Server has generated a critical event message.

Guest access to server is disabled. To access server information,
double-click the icon and enter the server password when prompted.

Server has generated a warning event message, such as an array
in Critical status.

Adaptec CI/O has lost communication with the server.

Double-click a server icon in the Server View window. The Server
Information dialog box appears, similar to Figure 2-2.

Figure 2-2: Server Information Dialog

2. View the server name, IP address, or IPX address.

3. View or edit the server description. The description is for your
information only and appears only in this dialog box.
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4. Click OK to exit the Server Information dialog box and to retrieve
any updated server information.

Deleting a Server Address

When you delete a server address, the icon for the server no longer
appears in the Server View window and you can no longer view
information for that server or manage it with Adaptec CI/O
Management Software.

Follow these steps to delete a server address:

1. Select Server View from the File menu.

2. Click the icon  of the server you want to delete.

3. Select Server Delete from the File menu. A prompt appears asking
you to confirm the deletion of the currently selected server address.

4. Click Delete to delete the server address.

Viewing a List of Current Server Events

When you run Adaptec CI/O Management Software, you can use the
Server View window to monitor events on all servers to which you are
connected. Event notifications appear at the top of the list as they are
received, starting from the time when you connect to the network. A
color- coded circle at the beginning of each message gives you a quick
indicator of its severity.

If you minimize Adaptec CI/O Management Software, the icon flashes
whenever a new event notification is received.

Follow these steps to view a list of current server events in the Server
View window:
1. Select Server View from the File menu. The Server View window

appears. The Global Current Event Log at the bottom of this
window lists server events, as shown in Figure 2-3.
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Figure 2-3: Listing of Server Events

2. View the event information for one or all servers. New entries
appear on the list as the server events occur, and a date and time is
listed for each event. See Interpreting and Responding to Server
Event Messages on page 85 for more information on how to
respond to these messages.

To view detailed information about an event, double-click the list entry.
The Log Detail dialog box appears, as shown in Figure 2-4.
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Figure 2-4: Log Detail Dialog Box

The information displayed in the Log Detail dialog box is similar to
what appears in the one-line log entry, but the format is more readable.

3. Click OK when you are finished viewing the Log Detail dialog box.
When you do this, you notify Adaptec CI/O Management Software
that you have read the event notification.

–  To acknowledge all new event notifications from all servers
without reading each individually, click OK to All at the bottom of
the Server View window. This stops the Adaptec CI/O
Management Software icon from flashing when the application is
minimized.

–  To acknowledge all new event notifications from the currently
selected server without reading each one individually, click OK to
Server at the bottom of the Server View window.

4. Click Filter in the Server View window to filter the events
notifications in this window by severity. (See Changing Filter
Options below.)

5. Click Save As to save the event list to a file.
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6. Close the Server View window when you are finished viewing the
server events or leave it open so you are aware of server events as
they occur.

Changing Filter Options

You can control what kinds of event entries are listed in the Global
Current Event Log (part of the Server View window) and the Historic
Event Log window. You can set the Filter options globally, or you can
customize them for individual windows. Follow these steps to change
the filter settings globally:

1. Click the  button on the toolbar. The Preferences dialog box

appears.

2. Click Filter. The Default Event Viewing Filter dialog box appears,
as shown in Figure 2-5.

Figure 2- 5: Default Event Viewing Filter

3. Select or deselect the Critical, Warning, or Informational entries
to control which kinds of messages appear in the Global Current
Event Log and the Historic Event Log. (We recommend that you
select all the boxes.) If you choose not to display some kinds of
messages, the Items displayed number above the log entries lists
the number of messages that are actually displayed. The Items total
field always indicates the total number of messages of all types.

4. Click OK to record the Filter option changes.
To change the Filter options only for a specific window, open the
Server View or Historic Event Log window and click Filter. Change
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the options as described above and click OK. The changed settings
apply to this window only while it is open; the settings will return to
the defaults if you close and re-open the window or if you restart
Adaptec CI/O Management Software .

Choosing Notification Settings

The notification settings determine how you are notified of events that
occur on servers to which Adaptec CI/O Management Software is
connected. The text describing these events appears in the list of
current server events and the Historic Event Log window.

Follow these steps to choose notification settings:

1. Click the  button on the toolbar. The Preferences dialog box

appears.
2. Click Notification; the Event Notification Options dialog box

appears, as shown in Figure 2-6.

Figure 2-6: Event Notification Options Dialog Box

3. Select Pop-up Box, Beep, and/or Flash Title Bar to control how
you will be notified of events that occur on servers to which
Adaptec CI/O Management Software is connected.

Note: Regardless of the options you choose, Adaptec CI/O
Management Software will always notify you of Critical events with
a pop-up message, a beep, and a flashing title bar.

4. Click OK to save these settings.



SUPERMICRO RAIDPort Manual

84

Viewing Historical Server Information
You can view a log of historical information for any single server to
which Adaptec CI/O Management Software is connected. This
information is retrieved from the server.

Follow these steps to view historical server information:

1. Click the  button on the toolbar. The Historic Event Log

window for the currently selected server appears, as shown in

Figure 2-7.

Figure 2-7: Server Historic Event Log Window

View the historical information for the server. New entries are added to
the top of the list as they occur. A color-coded circle at the beginning of
each message indicates its severity. (See the next heading, Interpreting
and Responding to Server Event Messages, for more information.)

2. To view detailed information about an entry on the list, double-click
the entry. The Log Detail dialog box appears, as shown in Figure
2-4.

3. Click OK when you are finished viewing the Log Detail dialog box.
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4. Click Filter to change the Message Filter options. Click OK to All
to acknowledge all new event notifications without reading each
one. (This stops the minimized Historic Event Log icon from
flashing.) Click Clear All to delete all log entries. Click Save As
to save the log to a file.

Note: When you open the Historic Event Log window, only the
most recent log entries are initially displayed. If you scroll down
beyond these entries, another group of entries are retrieved. This
avoids the delay that might occur if an entire large log file were
retrieved from the server at one time. To keep the Server Log file
from getting too large, specify a maximum size for it in the
initialization file.

5. Close the window when you are finished viewing log entries, or
minimize it as an icon on the screen.

Interpreting and Responding to Server
Event Messages
There are three severity levels for server events:

Critical event messages (red) indicate an array or server problem that
requires immediate action. An example is an array going off-line
because two array members have failed. See Responding to an Off-Line
Array on page 139 for more information.

Warning event messages (yellow) indicate an array or server problem

that may require attention. An example is a paused channel or a fault-
tolerant array with a failed disk. If no spare is available to replace the
failed disk, take action immediately before another disk fails. See
Responding to a Critical Array on page 137 for more information.

Informational event messages (green) contain information about a
normal operation, such as creating a new array, adding a spare, or

verifying an array.
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Entering and Viewing Preference
Information
Use the Preferences dialog box to enter or view information about how
event notifications are received from servers and to enable and
configure password protection for servers and networked clients.

Follow these steps to change or view preferences information:

1. Click the  button. The Preferences dialog box appears, as

shown in Figure 2-8.

Figure 2-8: Preferences Dialog Box

You can enter a different name for the configuration file that is stored
on the networked client. Click the Browse button if you want to store
this file in a different directory on the client’s hard drive.

2. Click Notification to change the way in which you are alerted of
event notifications sent from servers. The Event Notifications
Options dialog box appears, as shown in Figure 2-6.  Select one or
more of the available options.

3. Click Filter to view the Log Filter dialog box. Select or deselect the
check boxes, to filter the types of messages that appear in the
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window. We recommend that you select all the boxes so you are
fully informed of server events.

4. Select a Password Time-out option to set the level of password
protection for this workstation or server. See Setting Password
Time- out Options on page 134 for more information.

5. Click OK to change the option information or to close the dialog
box.

Editing the Permanent List

Each server maintains a permanent list and an active list of networked
clients. Clients that communicate with the server are automatically
added to the server’s active list. Adding a client name to the permanent
list allows that client to receive event notifications from the server even
when it is not actively monitoring the server. (If a client is on the
server’s permanent list but not the active list, the server icon does not
appear in the Server View window.) You can delete the client name if
you no longer want to be notified of events on a particular server.

When you edit the permanent list, you are required to enter the server
password.

Caution: We recommend that you do not use the Permanent
Notification feature for normal communications between servers
and networked clients. Servers can use the active list to rapidly
communicate new events to networked clients.

Follow these steps to add clients to or delete clients from the permanent
list:

1. Open the Server View window and select the icon of the server
whose permanent list you want to edit.

2. Select Server Administration from the View menu.

3. Select Edit Permanent List. Enter the server’s password at the
prompt. The Edit Permanent List dialog box appears, as shown
in Figure 2-9.
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Figure 2-9: Edit Permanent List Dialog Box

The list box shows the entries that are currently in the selected server’s
permanent notification list.

4. To add a new networked client entry, type the IP or IPX address in
the field at the top of the screen, select IP or IPX, and click
Add.

5. To delete a networked client entry, highlight the entry in the list box
and click Delete.

6. Click Close when you are finished. The changes are registered in the
server’s permanent list file.
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Section 3:
Configuring Arrays and Spares
This chapter explains how to add and delete arrays and spares with the
server console version or with the networked client version of the
Adaptec CI/O Management Software . The menus and commands are
the same for all supported versions of Windows.

You must know the Adaptec CI/O Management Software password to
add and delete arrays and spares. See Section 7, page 133, Setting
Security Options, for more information.

The following topics are explained in this chapter:

§ Creating an Array on page 91

§ Making an Array the First Virtual Device on page 96

§ Deleting an Array on page 97

§ Initializing an Array on page 99

§ Creating Dedicated Spares or a Spare Pool on page 100

§ Deleting a Spare on page 102

§ Arrays from External RAID Controllers on page 103

These features are available for PCI array controllers and Bridge array
controllers only. They are not available for SCSI adapters.

Starting the Program
Follow these steps to start the Adaptec CI/O Management Software and
prepare to configure arrays and spares. This assumes that the software
is already installed and that communications have been established
between the server and the networked clients or other consoles:

1. Start Windows.

2. Double-click the  icon in the Adaptec CI/O Management
Software group to start the program.
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Note: If you are running Adaptec CI/O Management Software from
a networked client and the message Guest Access Disabled
appears at this point, the server to which you are trying to connect
does not allow remote users to view its configuration information.
See Controlling Guest Access on page 135 for more information.

3. Open the Server View window by clicking the button on the
toolbar.

Note: If no Server icons appear in the upper part of the window,
enter information about the servers you want to monitor before
you continue. See Adding a New Server Address on page 75 for
more information.

4. Click the icon of the server whose arrays and spares you want to
configure, as shown in Figure 3-1. You can identify the server by
the name that appears beneath it.

Figure 3-1: Server Icons

If the icon appears dimmed, the server is off-line or otherwise
unavailable. (See Entering and Viewing Server Information on page 75
for more information about server icons.)

5. Open the Storage Configuration window by clicking the  icon

on the toolbar. All array and spare configuration tasks are done

from within this window.

Note: Depending on your system configuration, the Storage
Configuration window may open automatically when you start the
Adaptec CI/O Management Software. See the How-To Topics
section of the Adaptec CI/O Management Software online Help for
more information about this window.
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You can open other Storage Configuration windows for other servers to
which you are connected. To do this, return to the Server View

window, select a different Server icon, and click the  button
again.

Creating an Array
Follow these steps to create arrays with Adaptec CI/O Management
Software :

1. Start Adaptec CI/O Management Software and open the Storage
Configuration window, as described in Starting the Program on
page 89. This window looks similar to the one shown in Figure
3-2.

Figure 3-2: Storage Configuration Window

The icons on the left side of the Storage Configuration window
represent the server’s physical resources—the Adaptec Array1000
Family product s, AIC-78xx products, channels, and SCSI devices
installed in the server. The icons on the right side represent the server’s
array resources—the arrays and spares you define. Click the buttons in
the middle of the window to perform operations on selected Device
icons.
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2. Before you start defining the new array, decide what RAID level
you want to use, how many disks you want it to have, and whether
you want to define dedicated spares (spares that can be used only
by this array). The following table lists your Array options. See
Selecting a RAID Level for an Array on page 140 for information
on the advantages and disadvantages of each RAID level.

RAID Level
Minimum
Disks

Maximum4

Disks
Dedicated
Spares

Pool
Spares

RAID 0 (Striped) 15 16 None None
RAID 1 (Mirrored) 2 2 1 or 2 up to 8
RAID 0/1 (Mirrored
& Striped)6

4 16 1 or 2 up to 8

RAID 5 (Striped,
with Distributed
Parity)

3 16 1 or 2 up to 8

3. Select disks for the new array by clicking Disk icons that
have the word Single beneath them, as shown in Figure 3-3.

Figure 3-3: Selecting Array Members

                                                          
4 This is the maximum number of disks supported by the software driver.  The
maximum for your computer system may be less, depending on how many SCSI
channels and devices you have.
5 The purpose of one-disk RAID 0 arrays is to give you more control over the
virtual device order of disks controlled by the Adaptec Array 1000 Family product.
This is also useful for defining thesystem’s boot device.
6 RAID 0/1 arrays must have an even number of disks.
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Do not include disks that you want to use as dedicated spares. Click a
second time on an icon to deselect it, or click the Clear Selection
button to deselect all disk icons. All array disks must be connected to
the same Adaptec Array1000 Family product.

Note: Only devices attached to array controllers can be used for
arrays and spares. Devices attached to SCSI adapters can only be
viewed.

A warning appears if you select a disk that has a partition. If the
operating system recognizes the partition, you cannot use the disk in
the array. If the operating system does not recognize the partition (for
example, if the disk was previously partitioned under another operating
system), you can use the disk in the array.

You cannot use disks with recognized partitions for the array so you
will not accidentally erase the server’s boot disk. To find out if a disk

has a partition, double-click the  icon and click Check Partitions
in the SCSI Information dialog box. A small popup box indicates
whether the selected disk has a partition and whether the partition is
visible to the operating system. To use a disk with a recognized
partition in the array, exit from Adaptec CI/O Management Software ,
back up any data you want to keep, and delete the partition from the
disk.

Caution: All data on a disk is deleted when it becomes an array
member! Back up any data you want to keep before selecting a
disk as an array member.

4. Click Create Array.... The Create Array dialog box appears, as
shown in Figure 3-4.
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Figure 3-4: Create Array Dialog Box

The number of disks in the array and the array capacity are listed on the
right of the dialog box.

5. Type a name for the new array. The name can be up to 15
characters, including spaces and any other printable characters.

6. Select a RAID level for the array by clicking one of the buttons on
the left. The bar graphs on the right show the relative levels of data
protection, read performance, write performance, and capacity
utilization for each RAID level.

RAID levels appear dimmed if they are not consistent with the number
of disks you have selected. (See the table on page 92.) For example,
RAID 0/1 appears dimmed if you selected three disks, because a RAID
0/1 array must have at least four disks.

7. Select one or two disks from the list as dedicated spares. (Use Ctrl-
Click to select multiple disks.) The disks on the list are the single
disks you did not select as array members. The spare(s) you select
should be at least as large as the smallest array member. Otherwise
the usable capacity of each array member will be reduced to the
capacity of the spare.

We recommend using a spare pool instead of dedicated spares. See
Creating Dedicated Spares or a Spare Pool on page 100 for more
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information. Spares in a spare pool can be used by any array on the
controller.
8. Click Advanced... to examine or change the Advanced Array

options. The Advanced Array Options dialog box appears. See
Setting Advanced Array Options on page 95 for more information.

9. Click OK and then click Yes to confirm that you want to create the
array. If error messages appear, indicating that your array
selections are inconsistent, change your selections and click OK
again. A warning appears if you selected a dedicated spare that is
smaller than the array members.

The array is initialized at this point, unless you deselected
auto-initialize in Advanced Array options. (If you deselected auto-
initialize, skip to 11.) To abort the initialization process (not
recommended), open the Array Activity Monitor window, select the

icon for that array, and click Abort.

10. Wait until the new array is initialized. A popup box will appear to

inform you that event notifications are waiting and can be viewed

in the Server View window. Then an icon like this for the

new array appears in the right section of the Storage Configuration

window. Another event notification is generated when the

initialization process finishes.
Note: Event notifications may appear as popups or as entries in
the Server Historic Event Log and Event Log, depending on the
Event Notification options you selected in the Client Settings
dialog box.

11. Exit from Adaptec CI/O Management Software. Then reboot the
server. (You cannot use the new array until you reboot.) You must
partition the new array using the Windows NT Disk Administrator,
just as you would partition a new stand-alone disk drive.

Setting Advanced Array Options

The Advanced Array Options dialog box is shown in Figure 3-5. Do
not change these options from their default settings unless you have a
specific reason to change them.
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Figure 3-5: Advanced Array Options Dialog Box

Here is a brief description of the advanced options:

§ Stripe size is the size that will be used to stripe data or parity
information across the disks in the array. The optimal stripe size
depends on factors such as the type of data being stored on the
array and the server operating system. The default stripe size of
64 KBytes works best in most cases.

§ Deselect auto-initialize to create the array now but initialize it at a
later time. You can do this to define several arrays, then initialize
them all at the same time.

Caution: All arrays except RAID 0 arrays must be initialized or low-
level formatted before you can write data to them. We recommend
that you zero-initialize RAID 0 arrays as well.

§ Click Restore Defaults to restore the default Advanced Array
Options settings.

The default settings are the settings that existed when you opened the
dialog box. If you change the settings and click OK, these become the
new default settings for this array.

Making an Array the First Virtual
Device
Use this command if you want the server to boot from an array instead
of from a stand-alone disk. (To use a stand-alone SCSI disk as your
boot device, we recommend that you assign SCSI ID 0 to this device
and that you connect it to Channel A of the Adaptec Array1000 Family
product.)
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You make an array bootable by assigning it virtual device order #0. The
virtual device order is the sequence in which the server’s operating
system detects the arrays, single disks, and other devices connected to
the Adaptec Array1000 Family product when the server boots. You
may also need to move the Adaptec Array1000 Family product to a
different PCI slot. See your Adaptec Array1000 Family product’s
Installation and Hardware Guide for more information.

Caution: When you make an array bootable, the drive letters
assigned to other drives and arrays on the server may change,
which can cause data access problems on your system.

Follow these steps to create a bootable array:

1. Start Adaptec CI/O Management Software and open the Storage
Configuration window, as described in Starting the Program on
page 89

2. Click the icon in the right part of the window for the array

that you want to make bootable.

3. Click Operations.  Click .  When the message appears, click
OK to confirm that you want to make this array the boot device.

4. Exit from the Adaptec CI/O Management Software. If the selected
array does not already have a bootable partition on it, reboot the
server to a floppy disk.

5. Install the operating system on the array. See your Adaptec
Array1000 Family product ’s Installation and Hardware Guide for
more information.

The next time you boot the server, it will attempt to use this array as the
boot device.

Deleting an Array

Caution: Back up the data on an array before you delete it. All data
on the array disks is lost when you delete the array.

If you delete an array, all the disks that were part of the array become
single, stand-alone disks. You can then use the disks as spares or as
members of a new array.



SUPERMICRO RAIDPort Manual

98

Follow these steps to delete an array:

1. Start Adaptec CI/O Management Software and open the Storage
Configuration window, as described in Starting the Program on
page 89.

2. Click the icon  in the right area of the window for the array

you want to delete.

3. Click Operations.

4. When the Array Operations dialog box appears, click  to

delete the array.

A warning appears if the selected array has a partition. If the partition is
recognized by the operating system, you cannot delete the array. If the
partition is not recognized by the operating system, you can delete the
array.

You are prevented from deleting an array with a recognized partition so
you will not accidentally delete the server’s boot array. To find out if

an array has a partition, double-click the icon and click Check
Partitions in the Array Information dialog box. A small popup box
indicates whether the selected array has a partition and whether the
partition is visible to the operating system. To delete an array with a
recognized partition, exit from Adaptec CI/O Management Software,
back up any data you want to keep, and delete the partition from the
disk. Then start Adaptec CI/O Management Software again and delete
the array.

5. When the confirmation message appears, click OK to confirm that
you want to delete the array.

Note: After you delete an array you can immediately use the disks
that formerly belonged to the array to create spares or a new array
without rebooting the server. However, you must reboot the server
before you can use the disks as single disks that are not members
of an array. Deleting an array may change the boot order and the
drive assignment.
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Initializing an Array
When you create a new array it is initialized immediately by default
unless you deselect the auto-initialize option. If you deselect auto-
initialize, you can initialize the array later by following the instructions
in this section. You can also reinitialize an array that was previously
zero-initialized or low-level formatted.

Caution: All arrays except RAID 0 arrays must be initialized or
formatted before you can write data to them. We recommend that
you zero-initialize RAID 0 arrays as well. All data on the disks is
overwritten when you initialize an array.

To low-level format the array instead of initializing it with zeros, use
the _ArrayConfigSA™ program. Low-level formatting checks the
surface of the disks for defects.

Follow these steps to initialize an array to which data has previously
been written or a new array that has been defined but not initialized:

1. Start Adaptec CI/O Management Software and open the Storage
Configuration window, as described in Starting the Program on
page 89

2. Click the icon of the array you want to initialize. The

Operations button becomes active.

3. Click Operations.

4. When the Array Operations window appears, click the  button.

A warning appears if the selected array has a partition. If the partition is
recognized by the operating system, you cannot initialize the array. If
the partition is not recognized by the operating system, you can
initialize the array.

You are prevented from initializing an array with a recognized partition
so you will not accidentally erase the server’s boot array. To find out if

an array has a partition, double-click the  icon, and click Check
Partitions in the Array Information dialog box. A small popup box
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indicates whether the selected array has a partition and whether the
partition is visible to the operating system. To initialize an array with a
recognized partition, exit from Adaptec CI/O Management Software,
back up any data you want to keep, and delete the partition from the
disk. Then start Adaptec CI/O Management Software again and
initialize the array.

5. When the confirmation message appears, click Initialize to confirm
that you want to initialize the array.

To abort the initialization process (not recommended), open the Array

Activity Monitor window, select the  icon, and click Abort.
It may take a long time to initialize an array. You can watch the
progress of the initialization process in the Array Activity Monitor
window.

Creating Dedicated Spares or a Spare
Pool
Each RAID 1, 0/1, or 5 array can have one or two dedicated spares,
which automatically replace failed disks only for that array. You can
create dedicated spares when you create the array, or you can add them
to the array at a later time. Each Adaptec Array1000 Family product
can have a spare pool of multiple disks which automatically replace
failed disks on any array on the controller.

We recommend using a spare pool instead of dedicated spares if you
have two or more arrays on a controller. Spare pools give you more
flexibility and provide good data protection with fewer disks than is
required for dedicated spares.

Note: Adaptec CI/O Management Software is automatically
configured to test all spares on the server once a day to assure
they are always available to replace failed disks in arrays. We
recommend that you leave this default setting.

Follow these steps to add a dedicated spare or a pool spare:
1. Start Adaptec CI/O Management Software and open the Storage

Configuration window, as described in Starting the Program on
page 89.
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2. Select the disk you want to configure as a spare by clicking on its
icon in the left part of the window. (Choose a disk that has the
word Single beneath it.)

3. Click Create Spare... The Create Spare dialog box appears, as
shown in Figure 3-6. A list of already-defined spares appear on the
right. Names of existing arrays appear on the left only if the disk
you selected is large enough to protect that array as a spare.

Figure 3-6: Create Spare Dialog Box

Note: In the Storage Configuration window, pool spares are labeled
p-spare and dedicated spares are labeled d-spare in both the left
and right parts of the window.

4. If you want to dedicate the spare to a specific array, select
Dedicated To and click the array name in the scrollable list. If you
want to add the spare to the pool of spares available to all arrays on
the controller, do not select the Dedicated To box.

5. Click OK to create the spare. A warning message appears if you
select a disk that has a partition. If the partition is recognized by
the operating system, you cannot use the disk as a spare. If the
partition is not recognized by the operating system (for example, if
the disk was previously partitioned under another operating
system), you can use the disk as a spare.
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You are prevented from using disks with recognized partitions so you
will not accidentally erase the server’s boot disk. To find out if a disk

has a partition, double-click the  icon and click Check Partitions
in the SCSI Information dialog box. A small popup box indicates
whether the selected disk has a partition and whether the partition is
visible to the operating system. To use a disk with a recognized
partition as a spare, exit from Adaptec CI/O Management Software,
back up any data you want to keep, and delete the partition from the
disk.

Newly-created spares are immediately available for use, without
rebooting the server. If an array is in Critical status, it will be
reconstructed as soon as you have created the spare (unless the spare is
dedicated to another array).

Note: You can add a disk of any size to the spare pool, even if the
disk is too small to protect the existing arrays. For example, if you
have created two arrays with 1 GByte disks, you can add a
500-MByte disk to the spare pool, even though this disk is too
small to replace any failed array member. This allows you to create
a third array later with 500-MByte disks, for example.

To see which arrays are protected by an existing spare, select the spare
in the Existing Spares list; the arrays protected by this spare are
highlighted in the Existing Arrays list. You can double-click an array or
a spare to view detailed information about it.

Deleting a Spare
Follow these steps to delete a spare to use it as a stand-alone disk:

1. Start Adaptec CI/O Management Software and open the Storage
Configuration window, as described in Starting the Program on
page 89.

2. Click the icon in the Array part of the window for the spare you
want to delete.

3. When the confirmation message appears, click OK to confirm that
you want to delete the spare.
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After you delete an existing spare, and before you reboot the server,
you can use a former spare to create a new array or spare. However,
this disk does not become visible to the server operating system as a
single disk until after you reboot the server.

Arrays from External RAID Controllers
A bridge controller connects Fibre Channel-to-SCSI or SCSI-to-SCSI
external intelligent RAID array controllers to bridge the host I/O
interface to multiple back-end device channels. These devices appear
under a SCSI channel, but are capable of the same functionality as
SCSI devices connected to array controllers. Refer to the sections on
configuring and viewing arrays in this User’s Guide for specific
information on arrays.
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Section 4:
Viewing Array and Device
Information
The Adaptec CI/O Management Software allows you to view
information about arrays, spares, and SCSI devices on any server to
which you have access.

View this information in the Storage Configuration window. Follow
these steps to open the Storage Configuration window:

1. Select Configuration from the View menu, or click the  icon

on the toolbar.

2. When the Storage Configuration window appears, double-click the
icon that represents the device for which you want to view
information.

The Array and Spare icons are virtual devices that appear on the right
side of the Storage Configuration window. Virtual means that arrays
and spares do not exist until you configure them on the server.  See
figure 4-1.

Figure 4-1: Storage Configuration Icons
Physical Devices Logical Devices

Controller
Array

Channel
Spare

Disk Device

CD_ROM Drive
Other Physical Devices
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The Product, Channel, and SCSI device icons are physical devices that
appear on the left side of the window. Physical means that the icons
correspond to actual devices installed in the server, such as a SCSI
drive or a CD-ROM drive.

The following sections explain the information that appears when you
click an icon for a virtual or physical device.

Viewing Array Information

When you double-click an Array icon  in the Storage
Configuration window, the Array Information dialog box appears, as
shown in Figure 4-2.

Figure 4-2: Array Information Dialog Box

The following information appears in the Array Information dialog
box:
§ Status: current status of the array, such as OK, Off-line, Fault-

tolerant, Critical, etc.

§ Model: model name of the Adaptec product to which the array
disks are connected.

§ Array type: RAID level of the array. The supported levels are
RAID 0, RAID 1, RAID 0/1, and RAID 5.

§ Capacity: total usable disk space available in the array, in MBytes.

§ Member size: size of the array members.
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§ Array members: number of disks in the array.

§ Dedicated spares: number of spare disks dedicated to this array.

§ Available pool spares: number of pool spares available to protect
this array.

Click Check Partitions. A small dialog box indicates whether the
selected array has a partition and whether the partition is visible to the
operating system.

When you click Detail, you can view the following additional
information about the array:

§ Stripe size: data and parity striping size used on this array.

§ Virtual device order: the sequence in which the server’s operating
system detects this array when it boots. If the array’s virtual device
order is 0, then this array is the first device the operating system
detects at boot time.

§ Creation date: date on which the array was created.

§ Date of last verify: date on which the array was last verified. See
Verifying Array Integrity on page 117 for information on how to
verify an array.

§ Date of last reconstruct: date on which the array was last
reconstructed. See Reconstructing an Array on page 114 for
information on how to reconstruct an array.

Click Close to close the Array Detail and Array Information dialog
boxes.
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Viewing Spare Information

When you double-click a Spare icon in the right side of the
Storage Configuration window the Spare Information dialog box
appears, as shown in Figure 4-3.

Figure 4-3: Spare Information Dialog Box

When you double-click a Spare icon in the left side of the window, the
SCSI Information dialog box appears, as it does for a single SCSI disk.

The Spare Information dialog box shows which array the spare is
dedicated to, whether it is a member of a spare pool, its capacity, and
its current status. An Available status means the spare is fully
functional and is available to replace a failed array disk.

Note: The Spare icons in the Storage Configuration window are
labeled p-spare for pool spares and d-spare for dedicated spares.

Click Close to close the Spare Information dialog box or SCSI
Information dialog box.

Viewing SCSI Device Information
from an Array Controller

SCSI devices can be connected to array controllers as well as to SCSI
adapters. The same SCSI device information is provided in both cases.

Note: You cannot use a disk in an array if it has a partition that is
visible to the operating system. (This prevents you from
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accidentally deleting data or erasing your boot disk.) To use a disk
with a recognized partition in the array, exit from the Adaptec CI/O
Management Software program, back up any data you want to
keep, delete the partition, and then run the program again.

Rescanning the Server
Whenever you boot the server, the operating system software scans the
server for installed devices such as arrays and SCSI devices. Adaptec
CI/O Management Software displays icons for these devices in the
Storage Configuration window.

You may need to issue a Rescan command while Adaptec CI/O
Management Software is running so it can “see” the new hardware
configuration. You need to do a rescan if

§ Connect a new SCSI device to the Adaptec Array1000 Family
product without using the Pause I/O command

§ Disconnect a SCSI device from the Adaptec Array1000 Family
product without using the Pause I/O command

A rescan is done automatically whenever you pause I/O and resume I/O
to an array or a device. You do not need to issue a Rescan command to
detect a failed array member. Adaptec CI/O Management Software will
detect the failed member automatically if I/O is occurring on the array.

Follow these steps to rescan the server:

1. Click the  button on the toolbar. The Storage Configuration

window appears.

2. Click Rescan in the area between the Physical Resources and Array
areas of the window.

3. When the message appears, click Yes to confirm that you want to
rescan the server. When the rescan is complete, any hardware
changes are reflected in the icons in the Storage Configuration
window.
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4. Click OK when the message appears indicating that the rescan was
completed successfully.

Note: You cannot use the Rescan command to recognize an entire
array that was transferred from another server. You must reboot
the server before it recognizes the transferred array. However, if
you remove a disk that is an array member, replace it with another
disk, and issue a Rescan command, Adaptec CI/O Management
Software will detect that the new disk is no longer an array
member.

Viewing Array Controller Information

When you double-click a Controller icon , the Controller
Information dialog box appears, as shown in Figure 4-4.

Figure 4-4: Controller Information Dialog Box

The information in the Controller Information dialog box is self-
explanatory. The PCI bus number field indicates which PCI slot the
Adaptec product is installed in. You may need this information to
configure the server to boot from an array. For more information, read
the server documentation.

Click Capabilities to view a list of the features supported by this
Adaptec Array1000 Family product . The list is informational only; you
cannot enable or disable the capabilities on the list. These are controller
capabilities that may appear on the list (not all features appear for every
product):

§ Auto Verify: indicates that the product automatically verifies SCSI
parity.
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§ Auto Fix: indicates that the product automatically corrects data
and parity miscompares.

§ Supported RAID Levels: lists the RAID levels the product
supports.

§ Maximum Number of Spares: lists the maximum number of
dedicated spares per array that the product supports.

§ Maximum Number of Physical Arrays: lists the maximum
number of arrays the product supports.

§ Maximum Number of Drives for a Single Array: lists the
maximum number of disks the product supports for a single array.

§ Maximum/Minimum Stripe Size: lists the range of data and
parity stripe sizes that the product supports.

§ Spare Pool: indicates that the Adaptec Array1000 Family product
supports using spares from a spare pool.

Click Close to close the Capabilities dialog box and the Controller
Information dialog box.

Viewing Array Channel Information
When you double-click a Channel icon , the Channel Information

dialog box appears, as shown in Figure 4-5.

Figure 4-5: Channel Information Dialog Box
The following information appears in the Channel Information dialog
box:
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§ Status: current operational status of the channel (for example,
Active, Inactive).

§ Channel Type: type of this channel—for example, SCSI.

§ Maximum Devices: maximum number of SCSI devices that the
channel supports. For example, if this number is 16, you can
connect up to 15 devices, since the channel itself counts as one
device.

§ Current Devices: number of SCSI devices currently connected to
the channel.

Click Close to close the Channel Information dialog box.



SUPERMICRO RAIDPort Manual

113

Section 5:
Performing Array, Spare, and
Disk Operations
In Adaptec CI/O Management Software you can perform a number of
operations on arrays, spares, and stand-alone disks. These operations
include verifying the SCSI parity of arrays, reconstructing an array,
testing spares, and blinking the lights on one or more disks. Some of
the operations are performed immediately; others can be scheduled for
a later time, or scheduled to occur periodically at stated intervals.
To perform array, spare, and disk operations:

1. Select Configuration from the View menu, or click the 

icon on the toolbar.

2. When the Storage Configuration window appears, single-click the

icon that represents the array , spare , or SCSI disk

you want to work on.

3. When you do this, the Operations button becomes active.

4. Click Operations. The Array Operations, Spare Operations, or Disk
Operations dialog box appears.

5. Click the button for the operation you want to perform. See the
appropriate section of this chapter for a description of these
operations.

Performing Array Operations
A list of the array operations follows. Note that some of these
operations are described on page 89, Configuring Arrays and Spares.

§ Reconstructing an Array on page 114

§ Pausing I/O on an Array on page 116
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§ Verifying Array Integrity on page 117

§ Blinking Array Drive Lights on page 119

§ Reactivating an Off-line Array on page 120

§ Changing an Array Name on page 120

§ Forcing a Spare on page 121

§ Making an Array the First Virtual Device on page 96

§ Creating an Array on page 91

§ Initializing an Array on page 99

Reconstructing an Array

If a spare disk is available when an array disk fails, the array is
automatically reconstructed, and you do not need to use the Reconstruct
operation. However, if a disk in an array fails and no spare is available
to replace it, you receive an event notification that the array is Critical.
You may need to reconstruct the array with this command after the
drive is replaced. In either case, data on the array is not lost.

You can reconstruct an array immediately after you replace the failed
disk, or you can schedule the reconstruct to occur at a later time. Since
the reconstruction process may take a long time, you may want to
schedule it for a time when there is less activity on the server.

Follow these steps to reconstruct an array when a disk fails:

1. Determine which array is in Critical status and which disk in the
array has failed.

It is possible that a RAID 0/1 array in Critical status may have more
than one failed disk. The array can still be reconstructed without data
loss as long as at least one disk of each mirrored pair is still good.

2. If the array enclosure does not support hot swapping7, pause I/O to
the array. (See Pausing I/O on an Array on page 116.) This is not
necessary if the array enclosure does support hot swapping.

                                                          
7 Hot Swapping support means that the array enclosure electrically isolates the
bad disk’s SCSI connector from the SCSI bus while the disk is being swapped to
prevent data corruption.  Data can still be transferred to and from the remaining
good disks while the bad drive is replaced.
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3. Replace the failed disk (or disks) with a good disk of at least the
same storage capacity. Be sure that the SCSI ID of the new disk is
different from the SCSI ID of other installed devices. Or, if an
array disk was accidentally disconnected, reconnect it.

4. If you paused I/O in Step 2, wait until it automatically resumes after
the pause period. If you did not pause I/O, issue a Rescan
command to detect the new disk.

5. If you installed a new disk (or disks), make the disk into a spare by
following the directions in Creating Dedicated Spares or a Spare
Pool on page 100. Be sure the new spare disk is at least as large as
the smallest array member.

Note: When the spare is created, Adaptec CI/O Management
Software should automatically start a Reconstruct operation on the
array. If for some reason the reconstruct does not begin
automatically, follow the remaining steps to perform it manually.

6. Select Configuration from the View menu. The Storage
Configuration window appears.

7. Click on the Array icon that looks like this . The Operations

button becomes active.

Click Operations. The Array Operations dialog box appears, as shown
in Figure 5-1.

Figure 5-1: Array Options Dialog Box
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8. Click the button. If the array has one failed drive the

Scheduler dialog box appears.

If you have a RAID 0/1 array with two or more failed disks, and at least
one disk of each mirrored pair is still good, a dialog box appears with a
list of the failed drives. You must reconstruct the disks one-at- a-time,
starting over each time at the beginning of these steps. Select one of the
drivers on the list and click OK; the Scheduler dialog box appears.
(This assumes that you have already physically replaced all of the
failed drives with good drives.)

9. Enter the required information for the Reconstruct operation in the
Scheduler dialog box. You can select Immediate to reconstruct the
drive immediately or select Once to schedule the operation for a
later time. (See Setting Scheduling Options on page 127 for more
information.)

10. Select an Execution priority - high, medium, or low.

11. Click OK.

12. When the message appears, confirm that you want to reconstruct
the array member.

Read the event notifications that appear in the Server View window
(they may also appear as popups on the screen) to determine when the
reconstruct is complete.

Open a Watch box if you want to monitor the progress of the array
reconstruction. (See Monitoring Activities That Are Running on
page 130.)

Pausing I/O on an Array

Use this option to pause data I/O on an array while you replace a disk,
reconnect a loose connection, etc. If your array enclosure supports hot
swapping8, you probably do not need to pause I/O to replace a disk. See
the array enclosure documentation for more information.

                                                          
8  Hot Swapping support means that the array enclosure electrically isolates the
bad disk’s SCSI connector from the SCSI bus while the disk is being swapped to
prevent data corruption. Data can still be transferred to and from the remaining
good disks while the bad drive is replaced.
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When you pause an array, all other devices on all channels on the
Adaptec Array1000 Family product  are also paused. I/O is
automatically resumed after a specified pause interval.

Note: The Pause I/O command is disabled if a Verify, Reconstruct,
or Initialize operation is running.

Follow these steps to pause and resume I/O on an array:

1. Open the Storage Configuration window and select the icon of the

array  you want to pause.

2. When the Array Operations dialog box appears, click the 

button.

3. When the Pause I/O dialog box appears, enter a pause interval that
does not exceed the maximum allowable pause period, and click
OK to pause the array. Wait a few seconds until data I/O stops.

The Minimum pause period is 5 seconds; the maximum pause period is
120 seconds.

4. Do whatever you need to do with the array disks. Data I/O resumes
automatically at the end of the pause period.

Verifying Array Integrity

Use this option to verify the integrity of redundant data stored on fault-
tolerant (RAID 0/1, RAID 1, RAID 5) arrays. When you run this
operation, Adaptec CI/O Management Software checks the array for
miscompares and corrects parity errors automatically. A miscompare
occurs when the parity information on a RAID 5 array does not match
the user data or when some part of the data on a mirrored disk pair in a
RAID 0/1 or RAID 1 array does not match.

In Adaptec CI/O Management Software you can schedule the Verify
operation to run later or schedule it to run at a regularly occurring
interval. We recommend that you schedule a verification of all arrays at
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least once a week. See Setting Scheduling Options on page 127 for
more information.

Follow these steps to verify the integrity of redundant array data:

1. Select Configuration from the View menu. The Storage
Configuration window appears.

2. Click on the Array icon . The Operations button becomes

active.

3. Click the Operations button.

4. When the Array Operations dialog box appears, click the 
button to verify the data on the array. The Scheduler dialog box
appears, as shown in Figure 5-2.

Figure 5-2: Scheduler Dialog Box
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5. Leave the autocorrect box checked so that any data parity or
mirroring mismatches will be corrected automatically.

6. Select Immediate if you want to verify parity immediately, or select
Scheduled if you want to schedule the operation for a future time.

If you select Scheduled, enter a start time, start day of the week, and
other information. (See Setting Scheduling Options on page 127 for
more information.)

7. Select an Execution Priority - high, medium, or low. This sets the
system resources devoted to the operation. A high priority for the
Verify operation requires a lot of system resources, which may
slow down other system activity.

8. Click OK to start the operation (if you selected Immediate) or to
enter it on the list of scheduled activities.

9. When the message appears, confirm that you want to verify parity
information.

You can open a Watch window to monitor the progress of the operation
as it is running. See Monitoring Activities That Are Running, on
page 130, for more information.

Blinking Array Drive Lights

You can issue a command to blink the drive lights of all the disks in a
selected array. This allows you to see which physical drives actually
form the array.

Follow these steps to blink the drive lights of the disks in an array:

1. Select Configuration from the View menu. The Storage
Configuration window appears.

2. Click on an Array icon in the right side of the dialog box. The
Operations button becomes active.

3. Click the Operations button.

4. When the Array Operations dialog box appears, click the 

button.
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5. Look at the array enclosure to see which disks are members of the
array.

6. Click the Unblink all button in the Storage Configuration dialog
box to stop the drive lights from blinking.

Reactivating an Off-line Array

An array may go off-line because a cable is disconnected or because
you mistakenly remove the wrong disk while trying to replace a failed
disk. In these situations, the array shuts down temporarily. Depending
on the reason that the array went off-line, it is possible to reactivate it
and resume I/O without data loss. See Responding to an Off-Line Array
on page 139 for more information.

After you correct any hardware problems, follow these steps to
reactivate an off-line array:

1. Select Configuration from the View menu. The Storage
Configuration window appears.

2. Click on the dimmed icon of the off-line array. The Operations
button becomes active.

3. Click Operations.

4. When the Array Operations dialog box appears, click the 

button.

5. When the message appears, confirm that you want to reactivate the
array. Be sure that any hardware problems are corrected before you
do this.

Changing an Array Name

When you create an array, you assign it a name. This name appears
beneath the Array icon and in many of the windows and dialog boxes.
It is also used to identify the source of event notifications. You can
change this name at a later time.

Follow these steps to change the name of an existing array:

1. Select Configuration from the View menu. The Storage
Configuration window appears.
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2. Click the icon  of the array whose name you want to change.

The Operations button becomes active.

3. Click Operations.

4. When the Array Operations dialog box appears, click the 
button. The Change Name dialog box appears.

5. Type the new array name and click OK.

6. When the confirmation message appears, confirm that you want to
change the array name. This change appears immediately in the
Storage Configuration window.

Forcing a Spare

Forcing a spare means issuing a command for a spare disk to replace a
specific disk in an array. You can do this if the array disk is not
performing well and is giving some indication that an array member
may fail soon. (If an array member actually does fail, a spare replaces it
automatically without requiring you to force a spare.)

Follow these steps to force a spare:

1. Be sure that one or more spares are available for the array. These
can either be dedicated spares for the array or spares from a spare
pool. See Creating Dedicated Spares or a Spare Pool on page 100
for more information on configuring spares.

2. Select Configuration from the View menu. The Storage
Configuration window appears.

3. Click on the icon of the array with the suspect disk. The Operations
button becomes active.

4. Click Operations.

5. When the Array Operations dialog box appears, click the 

button. This button appears dimmed if no spares are available.

6. Select the disk that you want to replace.
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7. Click OK to replace this disk with a spare.

8. When the confirmation message appears, confirm that you want to
replace the disk with the spare.

At this point data I/O is paused to the disk, and the spare is
automatically activated to replace it.

If there is a pool of available spares, you cannot control which disk
from the pool is activated when you force a spare. You can control this
if there is only one dedicated spare or one pool spare. If both dedicated
spares and pool spares are available, the dedicated spares are used first.
If an error message indicates that the pool spare is not at least as large
as the smallest disk in the array, add a larger spare.

Performing Spare Operations
The following are spare operations available in Adaptec CI/O
Management Software.

§ Testing All Spares on page 122

§ Blinking the Spare Drive Light on page 123

§ Deleting a Spare on page 102

All spare operations apply only to the spares on the currently selected
server.

Testing All Spares

Reliable spares must be available to immediately (and automatically)
replace any array disk that fails. Spares should be tested regularly to
assure that they are working properly. We recommend that you test all
spares daily. You can run this operation immediately by issuing a
command, or you can use the Scheduler function to set up a recurring
check of all the spares at a time when few, if any, users are logged on
to the server.

Note: Adaptec CI/O Management Software automatically sets up a
daily Test All Spares operation on the server. We recommend that
you leave this default setting.
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Follow these steps to test all spares:

1. Select Configuration from the View menu. The Storage
Configuration window appears.

2. Click the icon of any spare on the right side of the dialog box. The
Operations button becomes active.

3. Click Operations.

4. When the Spare Operations dialog box appears, click the 

button. The Scheduler dialog box appears, as shown in Figure 6-2.

5. Select Immediate if you want to test all spares immediately, or
select Scheduled if you want to schedule the operation for a later
time.

6. If you select Scheduled, enter a starting time, starting day, and other
information.

7. Select an Execution Priority - high, medium, or low.

8. Click OK to start the operation (if you selected Immediate) or to
enter it on the list of scheduled activities.

9. When the confirmation message appears, confirm that you want to
test the spares.

10. Read the pop-up message that appears when the test is completed.

(The message is also recorded in the server Historic Event Log and

the Server View window.) If any spares failed the test, look at the

Spare Disk icons in the Storage Configuration window. The icons

of the failed disks will look like this .

11. Replace any failed disks immediately with good disks of at least
the same capacity.

Blinking the Spare Drive Light

You can issue a command to blink the drive light of a spare. This
allows you to see which physical drive is the actual spare.

Follow these steps to blink the drive light of a spare:
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1. Select Configuration from the View menu. The Storage
Configuration window appears.

2. Click a Spare icon in the right side of the dialog box. The
Operations button becomes active.

3. Click Operations.

4. When the Spare Operations dialog box appears, click the 

button.

5. Look at the array enclosure to see which disk light is blinking.

6. Click Unblink all in the Storage Configuration window to stop the
drive light from blinking.

Performing Disk Operations
You can perform the following disk operations with a single disk or
with a selected disk in an existing array:

Blinking the Drive Light on page 124

Downing the Drive on page 125

Pausing I/O to an Array Disk Drive on page 126

Blinking the Drive Light

You can issue a command to blink the light of a disk whose icon you
have selected. This allows you to see which physical disk corresponds
to the Disk icon.

Follow these steps to blink a drive light:

1. Select Configuration from the View menu. The Storage
Configuration window appears.

2. Click a Disk icon in the left side of the window. The Operations
button becomes active.

3. Click Operations.
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4. When the Drive Operations window appears, click the 

button.

5. Look at the array enclosure to see which disk light is blinking.

6. Click Unblink all in the Storage Configuration dialog box to stop
the drive light from blinking.

Downing the Drive

Use this option to stop all data I/O to a member of an array. You might
need to use this option if the disk generates a S.M.A.R.T.9 alert
indicating that it is about to fail. When you down an array member, a
spare is activated immediately (if available) to replace it, and a
reconstruct is triggered for RAID levels that support it.
The Down a Drive command can be used only for array members, not
for spare disks or single disks.
Follow these steps to down a disk:
Select Configuration from the View menu. The Storage Configuration
window appears.
Select the icon of the disk you want to pause.

Click Operations.

When the Drive Operations dialog box appears, click the

button. If a spare is available, it replaces the downed disk immediately
and a reconstruct of the array is triggered.

Wait until the Reconstruct operation is complete, then continue with
your work in the program.

                                                          
9 S.M.A.R.T. stand for Self-Monitoring Analysis and Reporting Technology.  Hard
drive that support this technology continually analyze their performance and
generate an alert if they determine that the disk is likely to fail in the next few
hours.  Adaptec CI/O Management Software generates an event notification if it
receives this alert, allowingyou to replace the disk before it actually fails.
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Pausing I/O to an Array Disk Drive

Use this option to pause data I/O on a disk drive that is connected to an
array controller. You can use this option to replace the disk if the array
enclosure does not support hot swapping10. See the array enclosure
documentation for more information. When you pause I/O to a disk
drive, all other devices connected to the Adaptec Array1000 Family
product are paused as well. I/O resumes automatically at the end of the
pause period.
The Pause I/O command is disabled if a Verify, Reconstruct, or
Initialize operation is running.
Follow these steps to pause data I/O to a disk:

1. Select Configuration from the View menu. The Storage
Configuration window appears.

2. Select the icon of the disk you want to pause.

3. Click Operations. When the Array Operations dialog box appears,

click the  button.

4. When the Pause I/O dialog box appears, enter a pause interval that
does not exceed the maximum allowable pause period, and click
OK to pause the disk. (You may need to enter the server.) Wait a
few seconds until data I/O stops.

Note: The minimum pause period is 5 seconds; the maximum
pause period is 120 seconds.

Complete your work before the pause period expires. I/O resumes
automatically at the end of this period.

                                                          
10 Hot swapping support means that the array enclosure electrically isolates the
bad disk’s SCSI connector from the SCSI bus while the disk is being swapped to
prevent data corruption. Data can still be transferred to and from the remaining
good disks while the bad drive is replaced.
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Section 6:
Scheduling and Monitoring
Array Operations
Adaptec CI/O Management Software enables you to schedule certain
kinds of operations to run at a later time, or to schedule them to run at
regularly recurring intervals. You create these as scheduled jobs at the
time you give the command to run the activity, as described in
Verifying Array Integrity on page 117, Reconstructing an Array on
page 114, and Testing All Spares on page 122.

Setting Scheduling Options
The Scheduler dialog box allows you to schedule the Reconstruct an
Array, Verify Integrity of Array, and Test All Spares operations.
Reconstruct an Array is a one-time event for which you can enter a date
and time. Verify Integrity of Array and Test All Spares can be
scheduled as hourly, daily, or monthly recurring events.

Follow these steps to set scheduling options for a newly added
operation:

1. Define a new scheduled operation: Reconstruct an Array, Verify
Integrity of Array, or Test All Spares. The Scheduler dialog box
appears, as shown in Figure 6-1.
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Figure 6-1: Scheduler Dialog Box

2. Select Immediate to perform the action immediately or Scheduled
to schedule it for later.

3. If you select Scheduled, select Once, Periodically, Daily, or
Weekly. Enter other information such as day of the week or start
time/date, as required.

Note: If you are scheduling an array reconstruct, you can only
select the Once option.

4. Click OK to record the scheduling options. You may be prompted to
confirm the activity.

Viewing and Managing Scheduled
Activities
You can view information about scheduled and currently running
activities in the Array Activity Monitor window. You can abort
activities that are running or delete scheduled activities. The Array
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Activity Monitor window shows scheduled tasks for the currently
selected server. To view activities on another server, select the Server’s
icon in the Server View window and open a new Array Activity
Monitor window.

Note: Adaptec CI/O Management Software automatically sets up a
daily Test All Spares operation on the server.

Follow these steps to view and manage scheduled activities:

1. Select Activities from the View menu. The Array Activity Monitor
window appears, as shown in Figure 6-2

Figure 6-2: Array Activity Monitor Window

2. Select an Activity icon from the left part of the window. Information
about the activity is shown in the window. Each kind of activity
has a unique icon. The icon labels indicate which array or spare the
activity applies to.

To view more detailed information about the activity, double-click the
Activity icon. The Scheduler dialog box appears, as shown in Figure
6-1. Click Cancel to close the dialog box.

3. To change the priority of a Verify or Reconstruct operation that is
currently running (as indicated by a moving icon), select the
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activity icon on the left of the window and then click Change
Priority. When the Change Priority dialog box appears, select an
option and click OK.

Note: The priority change applies only while the activity is running
this time. If it is a regularly scheduled activity, the next time it runs
it will have the priority originally assigned to it. You cannot change
the priority of an Initialize or Test all Spares operation that is
currently running.

4. To delete an activity that is not currently running, select its icon and
click the Delete button. After you confirm the command, the
activity is deleted from the list.

5. To abort a currently-running activity, select its icon and click the
Abort button. After you confirm the command, the activity stops
running immediately. If this is a regularly recurring activity, such
as a nightly test of all spares, it will run again in the future at the
next scheduled time. Use Abort and then Delete if you want the
activity to never run again.

6. Click the Watch button to open a small window to monitor the
selected, currently running activity. See the following section for
more information.

Monitoring Activities That Are
Running
You can open one or more Watch windows to monitor currently-
running array activities. You can leave these small windows open while
you continue doing other work on the computer.

When a Verify operation completes, the Watch window shows the total
number of miscompares. A miscompare occurs when the parity
information on a RAID 5 array does not match the user data or when
some part of the data on a mirrored disk pair in a RAID 0/1 or RAID 1
array does not match. If you checked the Auto Correct box in the
Verify dialog box, the miscompares are automatically fixed.

Follow these steps to monitor activities that are running:
Select Activities from the View menu. The Array Activity Monitor
window appears.



SUPERMICRO RAIDPort Manual

131

Select the icon of a currently-running activity from the scrollable list at
the top of the window.

Click Watch. A small Watch window for this activity appears, as
shown in Figure 6-3. Each window has a percent complete graph and a
Status field (OK or Failed). If a Verify operation is running, there is
also a field listing the number of miscompares found. Click Close to

close the Watch window after the activity has completed.
Figure 6-3: Watch Window
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Section 7:
Setting Security Options
Adaptec CI/O Management Software provides simple but effective
password protection to prevent unauthorized changes to array
configuration. Users who know the password can view server
information and can issue commands to add and delete arrays, add and
delete spares, and make other changes to array configuration. Users
who do not know the password can view server information but cannot
change array configuration. The network administrator can disable the
Guest Access feature (see page 135) for each server to prevent users
who do not know the password from even viewing server information.

The network administrator sets the initial password for each server and
controls users’ access to passwords.

Changing the Password
The Server Manager allows you to change password from any client on
the network.

Follow these steps to change the Adaptec CI/O Management Software
password:

1. Open the Server View window by clicking the  button. Then

select the icon of the server whose password you want to change.
2. Select Server Administration from the View menu. Then select

Change Password. The Change Password dialog box appears, as
shown in Figure 7-1.
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Figure 7-1: Change Password Dialog Box

If you are installing a password for the first time, type the default
password, “adaptec” in the Old Password field (password is case
sensitive).
Note: It is a good idea to change from the default password as
soon as possible, to prevent unauthorized users from entering the
Adaptec CI/O Management Software program.

3. Type the new password in the New Password field.

Passwords are case sensitive and can be up to 16 characters long,
including the characters A-Z, a-z, and 0-9. Spaces are not allowed.
Long passwords with a mixture of numerals and letters provide better
security. Do not use obvious passwords like your name, the name of a
family member, your birthday, your social security number, etc.

4. Type the new password again in the Confirm Password field.

5. Click OK to accept the new password.

Setting Password Time-out Options
The Password Time-out options allow you to control the way in which
users are prompted to enter the server’s Adaptec CI/O Management
Software password when they issue commands to change a server’s
array configuration. The Password Time-out options are set
individually for each networked client.

Follow these steps to change the Password Time-out options:
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1. Click the  button on the toolbar. The Preferences dialog box

appears.

2. Select one of the three password time-out options listed on the right
of the dialog box. Here is a description of the options:

–  No Password Time-out: Requires you to enter the password only
the first time (during each session) that you issue a command to
change array configuration. This option provides somewhat less
security than the others: if you leave your workstation unattended
after entering the password, another person can issue commands
from the workstation without being prompted for the password.

–  Always Require Password: Requires you to re-enter the password
every time you issue a command to change array configuration.

–  Enter Password Time-out Interval: Requires you to re-enter the
password at the stated time-out interval, whenever you issue
commands to change the array configuration. For example,
suppose that the time-out interval is 10 minutes. You start the
program at 9:00 and issue a command to create a new array on a
server. You are prompted to enter the password before the
command is accepted. After entering the password, you issue a
command at 9:05 to add spares to the spare pool; no password is
required. At 9:16 you issue a command to delete an array; since
you are beyond the 10-minute interval, you are prompted again to
enter the password before the command is executed.

3. Click OK to accept the password time-out change. You may be
required to enter the password in order to confirm the change.

Note: You must enter the password at least once after the
application has started, or when the setting has changed.

Controlling Guest Access
The Guest Access feature lets the network administrator control who is
allowed to view information about the server configuration. Guest
Access is enabled or disabled for each individual server. The Guest
Access setting affects all users who attempt to view server information
from networked clients. Here is how Guest Access works:
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When Guest Access is Enabled (the default), users who do not know
the Adaptec CI/O Management Software password can view server
information from a networked client connected to that server but cannot
issue commands to change the server configuration.

When Guest Access is Disabled, users who do not know the Adaptec

CI/O Management Software password cannot view server information

from a networked client or issue commands to change the server

configuration. However, users can still view event notifications

generated by servers that are on that client’s server list. Users who

know the password can view server information by double-clicking the

icon and entering the password.

Note: If you do know the server’s password you can perform array
operations such as Creating and Deleting Arrays whether Guest
Access is enabled or disabled.

Follow these steps to enable or disable Guest Access:

1. Open the Server View window by clicking the  button.
Then select the icon of the server whose Guest Access setting
you want to change.

2. Select Server Administration from the View menu. Then select
Guest Access.

3. When the Enable/Disable Guest Access dialog box appears, select or
deselect the Enable Guest Access check box.

4. Click OK to enter the change. Enter the Adaptec CI/O Management
Software password when you are prompted to do so.

The Guest Access setting is changed on the server.
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Section 8:
Managing Arrays and Spares
This chapter explains what to do when you need to replace a failed
drive, physically reconfigure the disks in your server, and perform
other tasks.

Note: These steps apply to devices connected to array controllers
only, and do not apply to SCSI adapters.

Responding to a Critical Array
A fault-tolerant (RAID 1, RAID 0/1 or RAID 5) array enters Critical
status if one disk in the array fails. The array continues to operate
normally, but you may lose data if a second disk in the array fails
before the array is reconstructed. (RAID 0/1 arrays can continue
operating in Critical status even if two or more disks fail, as long as at
least one disk in each mirrored pair remains operational.)

If a spare disk is available, the array management software will
reconstruct the Critical array automatically. When the reconstruct is
complete, the array returns to Fault-tolerant status. If no spare disk is
available, you should respond immediately to minimize the possibility
of data loss. The most effective strategy is prevention: be sure that
arrays are always protected by a spare pool or by dedicated spares!

In addition, you should monitor the status of arrays at all times with
Adaptec CI/O Management Software to detect arrays whose status is
Critical. You can monitor arrays effectively by enabling the Popup
Event Notification option so that a message appears on the screen
whenever an array enters Critical status. You can also tell that an array
is in Critical status if its icon in the Storage Configuration window

looks like this .

Follow these steps to return a Critical array to Fault-tolerant status:
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1. Click the Array icon  and observe the Disk icons of the array

members on the left of the screen. One of the icons should look

like this , indicating that the disk has failed.

2. Click the  icon and then click Operations.

3. When the Drive Operations window appears, click the .button

to blink the drive light on the failed disk.

4. Observe which drive light is blinking. This is the disk that you need
to replace. If no lights are blinking, this could mean one of the
following:

a) The disk is still connected but has failed so badly that it cannot
respond to the Blink command. Try blinking the drive lights of the
array disks that have not failed. You may be able to determine by a
process of elimination which disk has failed.

b) The disk has been removed or its power cord or SCSI cable has
been disconnected.

If an array disk has been disconnected or removed but the server has
not been rebooted, the icon for this disk will still appear in the Storage
Configuration window. If you know that the disk was disconnected
accidentally and has not actually failed, reconnect the drive and resume
I/O to the array.

If the server has been rebooted since the disk was disconnected, the
disk will not appear. To determine if a disk is “missing” from an array,
double-click the Array icon, and read the Status field at the top of the
Array Information dialog box. If this field says Missing member, a disk
is missing from the array.

c) The disk does not have an LED that indicates I/O activity.

5. If the array enclosure does not support hot swapping11, pause I/O to
the array before you continue. (Skip this step if the array enclosure
supports hot swapping.)

                                                          
11 Hot swapping support means that the array enclosure electrically isolates the
bad disk’s SCSI connector from the SCSI bus while the disk is being swapped to
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6. Replace the failed disk with a good disk, or replace the missing disk.
Be sure to complete this step before the pause period expires.

7. After I/O resumes automatically, select the icon of the new disk, and
issue a Create a Spare command.

8. When the spare has been created, select the Array icon and issue a
Reconstruct command, if necessary (it is possible that the
reconstruct will start automatically at this point).

9. When the reconstruct is completed the array is in Fault-tolerant

status again, and the array icon will look like this 

Responding to an Off-Line Array
You can tell that an array is in off-line status if OFFLINE appears in
the Array Status field in Adaptec CI/O Management Software for
_NetWare or if the Array icon in the Storage Configuration window

looks like this:  . There are several reasons for an array going
off-line, as described below:

§ A second disk in a Critical RAID 5 array has failed, or both disks
of a mirrored pair in a RAID 1 or RAID 0/1 array have failed.

If this happens, delete the off-line array, create a new array, and restore
the data from your most recent backup. You cannot recover the array
data if a second disk fails.

§ You were trying to replace a failed disk in a Critical RAID 1,
RAID 0/1, or RAID 5 array, but you mistakenly pulled the wrong
disk out of the array enclosure.

If this happens, reinsert the drive you mistakenly removed and issue the
Reactivate Array command, which returns the array to Critical status.
Then replace the correct disk, down the server, reboot, and reconstruct
the array.

§ A cable to a good disk in a RAID 5 array accidentally became
disconnected, and the array already had one failed drive; or a cable
to a good drive in a RAID 1 or RAID 0/1 array accidentally

                                                                                                                   
prevent data corruption. Data can still be transferred to and from the remaining
good disks while the bad drive is replaced.
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became disconnected, and the other disk of the mirrored pair had
already failed.

If this happens, reconnect the cable, and use the Reactivate Array
command to return the drive to Critical status. Then replace the failed
disk and reconstruct the array.

Optimizing Array Performance
If your Adaptec Array1000 Family product has multiple channels, you
may be able to achieve better sequential data access when creating
large arrays on powerful, high-end servers if some array members are
connected to each channel.

The array management software and drivers allow you to use disks of
various sizes and makes in the same array. To achieve the best
performance, however, we recommend that you use disks of the same
capacity and same model in an array. (If you use drives of different
sizes, the amount of capacity actually used on each disk will be
equivalent to that of the smallest disk in the array: For example, if you
use five 1-GByte drives and one 500-MByte drive, only 500 MBytes on
each disk will be used.)

You can also optimize array performance by selecting a RAID level for
the array that best meets your needs for data reliability, read/write
performance, and capacity use. See the following for more information.

Selecting a RAID Level for an Array

The term RAID means Redundant Array of Independent Disks. An
array is a grouping of disks that, by means of array management
software, appears to the computer’s operating system as one large disk.
Part of the storage capacity of most kinds of arrays contains redundant
information about the user data on the array12. If an array disk fails, the
contents of the disk can be regenerated on a new disk from the
redundant information on the other array disks.
Compared with single disks, arrays can provide one or more of these
desirable properties:

                                                          
12 RAID 0 arrays, which do not store redundant data, are an exception to this
definition.
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§ improved Read and Write performance by striping data across the
disks in the array. This allows data to be read from or written to
two or more disks simultaneously.

§ improved data reliability by storing redundant data to regenerate a
failed array disk, as described above. This is especially important
for servers, where arrays are most often used to store large
amounts of mission-critical data.

§ improved capacity utilization by allowing you to manage a large
number of disks as if they were one large disk. This makes it easier
to back up data, create directories, etc.

All disks of an array (including spares) must be connected to the same
Adaptec Array1000 Family product, though they can be connected to
different channels. You can create dedicated spare disks for each
RAID 1, RAID 0/1, and RAID 5 array. You can also create a pool of
spares that can be used by any RAID 1, RAID 0/1, or RAID 5 array on
the Adaptec Array1000 Family product .13

The array management software and firmware support RAID 0,
RAID 1, RAID 0/1, and RAID 5 arrays. The advantages,
disadvantages, and requirements of these RAID levels are as follows:

RAID 0 Arrays
Maximum Disks Allowed: 1614

Minimum Disks Allowed: 115

In a RAID 0 array, data is distributed, or striped, across the disks in the
array. The capacity of the array is approximately equal to the combined
capacity of the physical disks. The I/O performance of a RAID 0 array
is much better than that of a single physical disk because multiple reads
and writes can be handled in parallel and because when large files are
accessed the striped data is retrieved simultaneously from several disks.

RAID 0 arrays do not store redundant data and therefore are not true
RAID applications. If one disk fails, the entire array fails and all data is
lost. This means that the fault tolerance of a RAID 0 array is less than
that of any single disk in the array. The term RAID 0 is widely used for
                                                          
13 A disk in a spare pool can only be used to replace a failed disk in an array if it
is at least as large as the smallest disk in the array.
14 The maximum would be 15 disks if the system has a single SCSI channel.
15 One-disk RAID 0 arrays are used only to control the virtual device order of
single disks.
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these arrays, however, because they are conceptually similar to true
RAID applications.

RAID 1 Arrays
Maximum Disks Allowed: 2
Minimum Disks Allowed: 2

RAID 1 arrays use a single pair of disks. They are called mirrored
arrays because both disks in the pair contain the same data. When data
is written to a RAID 1 array it is written to each disk in the pair. The
read performance of a RAID 1 array can be much better than that of a
single disk, while the write performance is slightly worse. Mirrored
arrays are highly reliable because the data is still safe if one disk in the
pair fails. They are more costly, however, because you get only one
disk of actual storage capacity from the pair of disks.

RAID 0/1 Arrays
Maximum Disks Allowed: 16 (must be an even number)16

Minimum Disks Allowed: 4

RAID 0/1 disks use from two to eight pairs of disks. They are called
mirrored arrays because both disks in each pair contain the same data.
The read and write performance of a RAID 0/1 array is much better
than that of a single physical disk. RAID 0/1 arrays are highly reliable;
the array data remains safe so long as at least one disk of each mirrored
pair is good. Thus, in a 12-disk RAID 0/1 array, the array could
continue working with up to six failed disks if one disk in each pair is
still good. Because of the mirrored arrangement, RAID 0/1 arrays
require twice as many disks as the actual amount of storage space.

RAID 5 Arrays
Maximum Disks Allowed: 1617

Minimum Disks Allowed: 3

RAID 5 arrays contain redundant information in the form of parity
data, which is calculated block-by-block for all user data. The parity
data is distributed across all the disks in the array and occupies the
equivalent capacity of about one disk. User data is interspersed with
this parity data. If one disk in the array fails, its data can be
reconstructed from the user data and parity data on the other disks. Two

                                                          
16 The maximum would be 14 disks if the system has a single SCSI channel.
17 The maximum would be 15 disks if the system has a single SCSI channel.



SUPERMICRO RAIDPort Manual

143

disks must fail before the entire array fails. The read performance of
RAID 5 arrays is excellent and is comparable to that of a RAID 0 array.
Write performance is slower than that of a RAID 0 array, because new
parity data must also be calculated and written when user data is
written.


